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1 -  INTRODUCTION 

WHAT IS SMAART? 

Rational Acoustics Smaart® is a dual-channel, real time, FFT-based audio analyzer software application that 

enables you to measure and analyze the frequency content of audio signals, study the timing and response of 

sound systems and audio devices, and perform basic sound level measurement. Being a software application, 

Smaart is hardware independent and can process signals from nearly any audio device connected to your 

computer, which allows the flexibility to scale across a wide variety of field measurement and analysis 

applications. 

Smaart is available in four basic versions with different functionality: Suite, RT, LE, and SPL.  

• Smaart Suite is the flagship edition of Smaart, containing all three functional modes (Real Time, 

Impulse Response, and SPL).  

• Smaart RT (“Real Time”) is Smaart’s dual-channel real time FFT analysis toolset that also includes a 

host of advanced functions and mathematical parameters.  

• Smaart LE (“Light Edition”) is a streamlined version of the Real-Time toolset that offers the same core 

functions and input/output capability as RT, without access to some of the more advanced functions 

and measurement parameters.  

• Smaart SPL contains Smaart’s full sound pressure level monitoring, logging and reporting tools.  

Smaart LE is designed to provide all the essential tools and functions for modern real time sound system 

measurement and alignment workflows while maintaining an approachable and intuitive interface. It is closely 

aligned with the Rational Acoustics training curriculum and school of thought on sound system measurement, 

and as such can be considered the “everything you need and nothing you don’t” version of Smaart.  

WHAT IS TH IS GUIDE? 

This guide is a practical introduction to configuring and operating Smaart LE. Our goals are to provide a 

comprehensive explanation of the program and its features and operation, along with a brief survey of some 

of the core concepts related to acoustic measurement and analysis. For anyone interested in learning more 

about sound system engineering or acoustic measurement, a list of additional resources is provided in the 

appendices.   

We begin with the assumption that the reader has a basic understanding of professional audio equipment, 

engineering practices, and signal and system analysis, and focus on the configuration and navigation of 

Smaart. Users familiar with Smaart v8, Smaart Di v2, or previous versions will be able to quickly get up and 

running with Smaart LE. For those seeking to gain familiarity with the Smaart ecosystem and/or measurement 

concepts in general, an exploration of fundamental concepts and terminology can be found starting in Chapter 

4.  

As this user guide is an electronic document, in addition to the Table of Contents, the user can use a full text 

search to quickly locate any keywords of interests. In most PDF readers, the search function can be activated 

by using the keyboard shortcut [Ctrl/Cmd] + [F]. 
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A NO TE ABO UT SM AART’S H ELP FILES  

Smaart includes a comprehensive set of help files, which can be accessed from within the program by clicking 

Help in the program’s menu bar (found at the top of the main program window on Windows operating 

systems, or across the top of the display on macOS computers). These helpfiles contain a concise reference for 

features and functions within Smaart and are intended as a companion to this user guide. The helpfiles and 

this user guide contain much of the same material but organized in different ways. While this guide attempts 

to group information conceptually, the helpfiles are organized to be in parallel with Smaart’s user interface, to 

allow you to quickly “drill down” through menus, dialogs, and on-screen controls to find what you are looking 

for.   

HO TKEY AND MOUSE C LIC K NO TATION 

Since Smaart LE runs on both Windows and macOS, there are some minor differences in keyboard commands 

between the two versions. Specifically, the Control [Ctrl] key in Windows serves the same purpose as the 

Command [Cmd] key on macOS, and the [Alt] key in Windows is equivalent to the [Option] key on macOS. 

In this document, we’ll write the names of keys used for keyboard shortcuts (“hotkeys”) in brackets. In cases  

where Mac and Windows have different key names, both names will appear inside the brackets separated by a 

slash. For example, [Ctrl/Cmd] means the [Ctrl] key on Windows or the [Cmd] key on macOS. As regards the 

mouse, left-click on Windows is a regular mouse click on macOS. A right-click for Windows users means [Ctrl] + 

click on macOS. 

FULL SC ALE (D BFS) VERSUS FULL SC ALE  

There exist two competing references for decibels in digital audio signals. Once convention references dBFS to 

the largest possible amplitude value in a digital system, such that 0 dBFS denotes the maximum possible 

digital amplitude value. We refer to this as “normalized Full Scale.” 

The second convention, preferred by the Audio Engineering Society (AES), references 0 dBFS to the RMS value 

of a full-scale peak-to-peak sinewave (i.e. 0.7071 normalized Full Scale, rather than 1.0). We will call this “AES 

Full Scale.”  

In Smaart, Full Scale decibel values are always referenced to normalized full scale, meaning that the RMS level 

of a full-scale digital sinewave is -3.01 dBFS.  

GETTING STARTED 

To get started, you will need to install Smaart onto your computer and license the installation.  

M Y.RATIO NALACO USTIC S.COM 

The online account portal at my.rationalacoustics.com is the centralized location by which Smaart software 

licensing is managed. If you don’t already have an account, you should create one, and then you can register 

your new Smaart license by clicking the appropriately named “Register a new Smaart License” button on the 

Account Details page.  

You can also manage existing licenses, upgrade licenses and add installs, and download installers for macOS 

and Windows computers. Click the Downloads tab in the navigation bar to access downloadable installers for 

https://rationalacoustics-my.sharepoint.com/personal/michael_rationalacoustics_com/Documents/ALL%20MICHAEL'S%20STUFF/Documents%20and%20Articles/v9%20MANUAL/my.rationalacoustics.com
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all the versions of Smaart that are registered to your account, both for Windows and macOS. Take care to 

download the appropriate version.  

INSTALLING AND AC TIVATING 

Once the installer is downloaded, run it and follow the prompts. Smaart licenses are either Perpetual or 

Subscription. Perpetual licenses can be activated online or offline, while Subscription licenses can only be 

activated online. More detailed information about the activation process can be found in the Licensing Guides 

that appear in the Documentation section of the support portal at RationalAcoustics.com. If you require 

assistance with the licensing process, please contact Rational Acoustics support.  

ONLINE ACTIVATION (PERPETUAL OR SUBSCRIPTION) 

Following installation, the first time you run Smaart, you will be presented with an activation screen asking 

you to select your license type – perpetual or subscription. The next page will ask for your license code, 

followed by your my.rationalacoustics.com account information. The final screen will ask for your name and 

email address, as well as a Computer Name identifier of your choice. Then click Activate to activate your 

license. 

OFFLINE ACTIVATION (PERPETUAL ONLY) 

If you need to activate Smaart on a computer that is not connected to the Internet, you can manually register 

the Smaart Machine ID from within your account at my.rationalacoustics.com Open Smaart on the computer 

that is not connected to the Internet and note that the Machine ID will be displayed on the Offline Activation 

screen (clicking the Machine ID will copy it to your clipboard). 

From any device that is connected the Internet, open a web browser, navigate to 

https://my.rationalacoustics.com, and log in to your license management account. Once logged in, you’ll see a 

list of all Smaart licenses registered to your account. Click on your Smaart LE license code and you will be 

brought to its Details page. 

Click the link next to “If you do not have an internet connection” under Download and Install. Within the form 

it brings up, enter your Machine ID, the name and e-mail address you want to associate with this installation, 

and a friendly name to identify the computer. There is also a field for a Block Code, however you can ignore 

this unless you are reactivating an installation on a computer that was previously deactivated. When you finish 

entering the required information, click the Submit button to get your Activation Code. Go back to Smaart on 

your offline machine, enter the Activation Code into the “Offline Activation” section, and click the Activate 

button. If the code is correct, you will see a success message. 

BASIC COMP UTER REQUIREMENTS 

You can find the most up-to-date minimum system requirements for Smaart v9 on our website at 

rationalacoustics.com. The minimum system requirements for Smaart v9 have changed from v8, and may be 

updated as new hardware, operating systems and program features become available. These minimum 

requirements are established to ensure reasonable performance when default settings are used. You should 

consider a more powerful computer if you plan to use large FFT sizes or run many measurements at the same 

time.  
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2 – GETTING STARTED – NAVIGATING SMAART 

Now that you have Smaart installed, activated, and ready for use, let’s take a brief look at some of the 

fundamental concepts and features that you’ll want to be familiar with as you work with the software. 

FUND AMENTAL PARAD IGM S AND TECH NO LOGY 

SM AART IS A TOO L – YOU ARE TH E ANALYZ ER 

Perhaps the most important thing to keep in mind when working with Smaart is that, conceptually speaking, 

Smaart is a measurement tool. Taking a measurement is asking a question – and Smaart can perform a wide 

variety of measurements to answer different questions. Therefore, using Smaart effectively requires you to be 

thinking about what question you’re asking. Like all measurement tools, which exist to display information to 

the user, Smaart displays information about the signals we send it.  

Deciding what signals or microphone positions to feed Smaart is part of the decision-making process that 

allows us to gather repeatable, actionable measurement data that will help form a solid basis for our 

decisions. But we must keep in mind – we make the decisions. Smaart is just a tool we use to make our 

decisions more informed. In other words – Smaart is a tool, you are the analyzer.  

M ULTI- INP UT/O UTP UT, MULTI-ENGINE 

Since Smaart’s core function is to display information about the signals it receives, it is important to 

understand how Smaart acquires those signals. Smaart’s multi-device, multi-input capabilities mean that the 

analyzer can access any number of signals at once, from multiple audio devices at once. There are no 

software-imposed limitations on the number of signals or devices – you are limited only by what your 

computer and hardware can accommodate. Though there are sometimes limitations imposed by the 

computer’s operating system and/or device drivers (for example, a single ASIO-based device at once on a 

Windows computer), Smaart should be able to access signals from any audio device that is connected to and 

recognized by your operating system. Likewise, Smaart’s signal generator can output to any connected 

devices.  

Once input devices and channels are configured, they can be selected to feed as many spectrum and transfer 

function measurement engines as you desire. Each measurement engine can have its own unique 

configuration, which allows you to configure multiple engines to generate different data from the same input 

signal(s).  

LIVE AND STORED MEASUREMENTS 

At any time, the data produced by a measurement engine can be captured and stored into Smaart’s data 

library, which is found in the Data Bar along the left side of the main window. Measurement data is always 

captured directly at full resolution, regardless of the current banding or smoothing settings, so that those 

parameters can be adjusted later without any changes to the raw underlying measurement data. Smaart 

allows you to hide and show both live and stored measurement data and work with both at once in the same 

plot.  
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GRANULARITY OF CONTROL 

Smaart utilizes a tiered system for control over measurement engine parameters – a global control sets the 

overall behavior of a parameter, and individual engines can be exempted from global and set individually. For 

example, you can set the global averaging for all Spectrum engines using the dropdown in the control bar, and 

you can also exempt individual engines from following the global setting and give them an individual averaging 

setting. This would be helpful for investigating the differences between averaging settings, or for providing 

two views of the same signal for additional context.   

H IGH LY CO NFIGURABLE 

Smaart’s default settings have been carefully chosen to allow you to start taking actionable measurements 

without the need for extensive setup or configuration. However, Smaart can be configured to best suit a given 

application. Central to the successful use of Smaart is your ability to view the data in a way that is useful – that 

is, knowing how to configure Smaart to show you what you need to see to answer the questions you’re asking. 

Although Smaart LE has some measurement parameters pre-selected, there is still a high level of 

configurability to lay out the program interface, data, and views as you desire.  

Smaart is designed to allow the program configuration to be easily and actively modified “on the fly” as you 

work. The on-screen controls, hotkeys and view presets allow you to quickly change window layouts and plot 

views as you go. Preferred and commonly used configurations can be easily stored and recalled, as well as 

view presets and plot zooms. Taken together, these features offer the flexibility to help you acquire the 

necessary data and display it in a helpful way as efficiently as possible.  

CO NTRO L P RIORITY 

Controls in Smaart are arranged in order of priority. Controls that are typically adjusted frequently throughout 

a measurement session, such as smoothing and averaging, are easily accessible via the top level of the 

interface, whereas controls and settings found within Smaart’s Options menus might be accessed once per 

measurement session or less. In other words – the more clicks it takes to get to a setting, the less likely it is 

that you need to adjust it frequently. 
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WELCOME TO SMAART – A GUI TO UR 

In this section, we’ll help you familiarize yourself with the layout of Smaart’s graphical user interface (GUI) by 

taking a quick tour through the major elements. 

 

Figure 1 - Smaart LE interface overview. Data Bar (red), Control Bar (gold), Graph Area (green), Command Bar (blue) and Cursor Readout 

(purple) 

INTERFAC E CONTRO L BARS 

Smaart LE’s main program window consists of a data display area in the center framed by control bars on 

three sides. Taken together, these bars house the major interface elements via which Smaart is operated. 

DATA LIBRARY 

Along the left side of the program window is the Data Library, which is home to all stored measurement data. 

When a Spectrum type plot (RTA or Spectrograph) has focus, the Data Library shows captured Spectrum data. 

Likewise, when a Magnitude or Phase plot has focus, the Data Library displays shows saved Transfer Function 

measurement data. The Data Library is a live view of the stored data files in your computer’s Documents 

folder, inside the Smaart LE\Data subdirectory. 

CONTROL BAR 

The Control Bar is found along the right side of the main program window. The Control Bar, true to its name, 

houses measurement engine controls. At the top of the Control Bar is a docked level meter which doubles as a 

clock. At the bottom of the Control Bar is the Signal Generator, as well as a button to open the Views flyout. 
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Like the Data Bar, the Control Bar shows Spectrum engines and controls when a spectrum-type plot has focus, 

and Transfer Function engines and controls when a transfer function-type plot is selected.  

COMMAND BAR 

The Command Bar spans the bottom of the main program window and contains 10 Command Buttons. Each 

Command Button can be user-assigned to any function or command in Smaart that has a keyboard shortcut 

associated with it by opening the Config menu and choosing Command Bar Config.  

D ATA / P LOT AREA 

The plot area inhabits the center of the program window and is the majority shareholder of screen real estate 

in Smaart. This is where live and stored measurement data is displayed. The plot area can be a single graph, or 

divided into two. When a Transfer Function graph type (Magnitude or Phase) is visible, an additional Live IR 

plot is shown at the top of the plot area by default. 

PLOTS 

Plots are the central focus of Smaart – they are where live and stored measurement data is displayed and 

manipulated. All plots in Smaart follow the same convention for identification and navigation: the upper left 

corner of each plot shows the type of graph (RTA, Spectrogram, Magnitude, Phase, etc). Click the plot label 

text or the arrow next to it to open the droplist and change the plot to a different type.  

Likewise, all plots in Smaart always display the name of the currently displayed measurement data. If more 

than one measurement is displayed in the plot, the name of the measurement at the top of the z order will be 

displayed. Click the data name text or the arrow next to it to open the Plot Legend, which allows you to view 

and control all measurement data currently displayed in that plot. 

CURSOR READOUT AREA 

Across the very top of the plot area is the Cursor Readout Area. The cursor readout always displays precise 

information about the data under the cursor location (amplitude, frequency, or time units depending on the 

data type). The cursor readout can also display Wavelength or musical Note ID on frequency-domain graphs, 

and distance units on time-domain graphs, by enabling these in the Cursor tab of the Options > Preferences 

dialog. The cursor has a number of helpful functions and options, see Cursor Readout on page 42. 

MENUS 

Smaart’s main menus span the top of the program window on Windows, and the top of the display on macOS.  

The top level menus collect functions into general categories (File, Config, Options, View, Command, Window, 

and Help). In this guide, carets will indicate the navigation path through the menus and any submenus. For 

example, Options > Measurement Settings > Transfer Function means to open the Options menu, choose the 

Measurement Settings entry, and then select the Transfer Function.  

C LOC K / BRO AD BAND LEVEL METER 

At the top of the Control Bar is a broadband level meter. The dropdown in the upper right allows you to select 

an input to view on the meter. The dropdown below that allows you to select the sound level metric, although 
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you are only able to view sound level information for inputs that have been calibrated for SPL. The full scale 

digital level (dBFS) can be viewed for all inputs.  

The broadband meter can also be swapped for a clock, if desired, by right-clicking the meter and choosing 

Toggle Clock, or by pressing the hotkey [K].  

LAUNCH ING SMAART 

FIRST LAUNCH VS SUBSEQUENT LAUNC HES 

The first time you launch Smaart LE, it will display a message that no measurement engines are configured and 

invite you to start the process by selecting input sources. When you click OK, Smaart will display the IO Config 

dialog.  

 

Figure 2 - The First Launch dialog, informing you that no measurements are configured and that you should start by selecting input signals. 

On subsequent launches, Smaart will offer you a choice. Choose “Continue with the current configuration” to 

pick up where you left off last time. Choose “Create a new Configuration” to keep your existing settings but 

choose new inputs and create new measurement engines. Choosing “Select a previous configuration” will 

allow you to load a configuration you’ve saved previously. 
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Figure 3 - the Select Config dialog that appears on subsequent launches 

Note that at any time, you can completely restore Smaart to its default settings by choosing Manage 

Configurations from the Config menu and clicking the Restore Defaults button.   

INITIAL CO NFIGURATIO N – GETTING INPUT SIGNALS 

In order to start our work, we have to get input signals into Smaart – we do this by selecting which input 

device(s) we wish to use, and which channels on those devices. This is done in the IO Config dialog, which 

Smaart will automatically display on first launch.  

 

Figure 4 - the Input tab of the I-O Config dialog 
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The IO Config dialog has two tabs, Input and Output. Of course, most IO devices have both inputs and outputs, 

but the operating system – and therefore, Smaart – can treat them separately. At the top of the Input tab is 

the devices table, which lists all audio devices that your operating system recognizes. While previous versions 

of Smaart required IO devices to be connected and recognized by the operating system before launching the 

software, Smaart v9 can dynamically detect IO devices connected at any time. Once you connect your device, 

it should populate in the top pane of IO Config dialogue after a short delay, provided the proper drivers are 

installed.  

To select a device for use in Smaart, click its check box in the Use column. The API: Driver Name column lists 

the name that the audio device (or its driver) reports to the operating system. On macOS, all devices will use 

CoreAudio. Windows machines may have ASIO and Wave API devices, and some devices may appear as both 

types.  

Note: If you have both Wave and ASIO drivers installed for an IO device with more than two channels, it will 

typically show up as a single ASIO device, and multiple Wave devices since the Wave API only supports two 

input channels per device.  

In the Friendly Name column, you can assign an alternative name to a device if you choose – remember to 

press the [Enter] key after typing the name to apply your change. 

The Status column indicates either OK or N/C for each device. OK means that Smaart was able to successfully 

connect to the device and it is ready for use, while N/C means “not connected”. N/C can mean really not 

connected – Smaart remembers the device was connected previously, but it is no longer present – or it can 

indicate some hardware or software problem prevented Smaart from communicating with the device. This 

could be a device driver issue, a loose cable, or the device needs to be restarted. You can remove an N/C 

device by selecting it in the list and clicking the Remove button to the bottom right of the devices table.  

Enabling a device for use in the devices table will create a tab for it below the device table. The Input Channels 

table has 7 columns, the last of which is a live signal input meter for each input. 

The check boxes in the Use column allow you to select the inputs you want to use in Smaart and ignore the 

rest. Note: clicking directly on the word Use in the column header will quickly select / deselect all inputs at 

once. The Ch column lists the channels by number, and Channel Name lists the driver-reported channel name 

for each.  

You can assign a Friendly Name for each channel to help you identify it when you see it elsewhere within 

Smaart – make sure to press the [Enter] key to set the name after you’re done typing and move down to the 

next channel on the list.  

The Cal Offset column indicates the calibration offset for sound level measurements. A calibration offset of 

zero means the input is not calibrated for sound level measurements. Once the input has been calibrated, the 

Cal Offset value displayed corresponds to the acoustic level at the microphone that will bring that input’s 

convertor to 0 dBFS. For more information, see Sound Level Calibration (Only Needed for SPL Measurement) 

on page 80. 

The Mic Correction Curve selector allows you to assign microphone correction curves to input channels if 

desired. For more information on importing microphone correction curves, refer to Microphone Correction 

Files on page 79.  
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Below the Input Channels table is a Clear Settings button which will reset the device’s configuration by 

clearing out all calibration offsets, microphone correction curves, and friendly names. To the right, the 

Calibrate button opens the Amplitude Calibration dialog and defaults its selection to the currently selected 

input.  

INITIAL CO NFIGURATIO N – SELECTING OUTPUTS 

The Output tab of the IO Config dialog looks and operates much like the Input tab. To select a device for use in 

Smaart, click its check box in the Use column. In the Friendly Name column, you can assign an alternative 

name to a device if you choose – remember to press the [Enter] key after typing the name to apply your 

change. 

 

Figure 5 - the Ouput tab of the I-O Config dialog 

Selecting an output device for use creates a tab for it below in the device table. The device’s output channels 

are displayed in the table, and you can select any / all outputs you wish to use by checking the Use box for 

each. When the Signal Generator is running, it will route signal to all selected outputs on all devices you have 

selected for use. See The Signal Generator on page 51. You can assign each output channel a friendly name to 

help you keep things organized. Make sure to press [Enter] when you’re done typing to set the name. 

The Trim column allows you to apply attenuation individually to each selected output channel if desired. Only 

negative values are allowed – make sure to press [Enter] to set the change. 
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UND ERSTAND ING LEVELS OF CO NFIGURATIO N 

Smaart has several hierarchical levels of Configuration. In the Config menu, the Manage Configurations dialog 

allows you to store and recall the entire program state, including IO Config, Measurement Config, and all 

settings and options.  

There are multiple lower levels of configuration within Smaart that deal with specific segments of the 

program. Input Config deals solely with input devices, channels, mic correction files and calibration offsets. 

Output Config addresses output devices, channels, and trims. Measurement Config includes all configured 

Spectrum and Transfer Function engines, SPL Config addresses meter display colors and Leq time and 

weighting, and Command Bar Config dictates which functions are assigned to the Command Bar across the 

bottom of the interface. All these items are accessible via the Config menu, and are collectively stored, 

recalled, and reset via the Manage Configurations dialog.  

 

Figure 6 - the Config Management dialog 

The Manage Configurations dialog, accessible from the Config menu, will allow you to save the current 

configuration at any time by clicking Save As, entering the name for the configuration, and clicking OK. The 

Restore Defaults button will completely restore Smaart to its default state, including all configurations and 

settings.  

Choose a stored configuration from the list and click Recall, and confirm with Yes to restore it.  Use the Delete 

button to delete a stored configuration, Copy to duplicate it, and Overwrite to update the stored configuration 

with the current program configuration.  

 

THE SMAART V9 FILE STRUCTURE 

Smaart stores all its captured measurement data and configuration data in your computer’s Documents 

directory, in a folder called Smaart LE. Inside the Smaart LE folder are several subfolders, including the Config 

folder, which houses Smaart’s config data and any saved configurations, and the Data folder, where saved 

measurement data is kept. 
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MEASUREM ENT DATA 

Smaart LE produces two main types of stored measurement data - .srf files are saved Spectrum measurement 

data, and .trf files are saved Transfer Function measurement data. Inside the Documents\Smaart LE\Data 

folder, you will find folders labeled Spectrum and Transfer Function which hold captured .srf and .trf data, 

respectively. The Data Bar within Smaart is a “live view” of these two folders, so renaming or deleting a saved 

measurement inside the Data Bar will do so inside the Data folder as well. The converse is also true. If Smaart 

doesn’t automatically update to reflect changes to stored data you’ve made via your computer’s file browser, 

you can click the three line (hamburger) menu in the data bar and select Refresh Data Library. 

CO NFIGURATIONS 

Stored configurations are kept in the Documents\Smaart LE\Config folder, along with Smaart’s current running 

configuration, which is stored in the SmaartConfig.xml file. Deleting this file is the equivalent of using the 

Manage Configurations dialog to reset Smaart to defaults and is useful in the case of unexpected behavior or 

as directed by Rational Acoustics support.  

Stored configurations contain information about the total program state, including hardware-specific 

information, so it is not recommended to attempt to transfer stored configuration files between computers. 

OTHER PROGRAM FILES 

Also within the Documents\Smaart LE directory are two more folders: Skins and TargetCurves. 

The Skins folder contains any custom skins you make for Smaart in the Skins tab of the Preferences dialog 

(found in the Options menu). You can share a Smaart skin with a friend or to another machine by copying the 

custom skin’s .xml file from this directory and pasting it into the same directory on another computer.  

The TargetCurves folder houses Target Curves available for display on Smaart’s RTA plots (see Target Curves 

on page 29 for more information). Target curves can be imported into Smaart via the File > Import > Target 

Curve function or via the Options > Target Curves dialog.   
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3 – CONTROLLING SMAART AND VIEWING DATA 

Successful measurement sessions hinge upon the ability to control the program and display acquired data in a 

way that is useful to answer the questions at hand. This chapter is a look at all the interface elements and 

controls in Smaart.  

FUND AMENTAL CONC EPTS 

WAYS TO CONTROL SM AART 

To allow for a wide variety of approaches, workflows and applications, there are multiple ways to control 

Smaart. The first is the mouse cursor, by interacting directly with onscreen data and controls, plus the menus 

and options dialogs that can be accessed via the program’s Menu bar at the top of the main program window 

on Windows computers, or at the top of the computer screen on macOS computers. 

Second, Smaart offers a wide variety of hotkeys for various functions. A full list of hotkeys is available in the 

program’s help files, and any menu functions having hotkeys will list the key combination directly alongside 

the menu entry itself. 

Alternatively, Smaart’s Command bar, across the bottom of the screen, offers Command Buttons that can be 

freely assigned to your favorite commonly used functions – simply click a Command button to execute the 

assigned function. You may wish to begin with the default assignments and gradually assign them to your 

preferred functions as you become more familiar with the program and establish a workflow.  

CAPTURE VS DISPLAY 

When working with Smaart, it is critical to distinguish between the measurement data itself, and how it is 

displayed. For example, when capturing a spectrum measurement, Smaart always stores the raw full 

resolution data, independent of what banding setting was in use at the time the data was captured. Since the 

raw, full resolution data has been retained, the data can later be displayed with any desired banding setting.  

Conversely, when a measurement is captured, the measurement data is the result of whatever averaging 

setting the measurement engine was using at the time the data was produced and captured. Since the stored 

measurement was produced from the output of the average, the amount of averaging used cannot be 

changed once the data has been captured. In Smaart v9, care has been taken to locate the “view” settings in 

the plot itself, where the data is viewed, and locate the measurement settings – which affect how the 

measurement engines produce the data – within the measurement configuration dialogs. Thus, the interface 

and control paradigm are helpfully laid out in a way that helps to draw the distinction between data 

generation and data viewing.  

LINEAR VS LO GARITHM IC P LO T SC ALING  

One thing we must be mindful of when measuring acoustic information and plotting it on graphs is that 

human perception of sound is logarithmic and covers a relatively large range of values. For example, the entire 

range of sound levels that humans can hear, between the threshold of audibility and the threshold of pain, is 

approximately 120 decibels, which in linear terms is a ratio of a million to one.  
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Likewise, the frequency range of human hearing is typically defined as 20 Hz to 20 kHz, a range of three 

“decades” or logarithmic orders of magnitude. Since we hear more or less logarithmically, our ears perceive 

the percent difference between two frequencies as a constant. In other words, we would perceive the jump 

from 500 Hz to 1 kHz as the same jump in frequency as 1 kHz to 2 kHz. In both cases, it’s a doubling of 

frequency (an “octave”). We usually plot our frequency-domain data on a logarithmic scale such that those 

two intervals occupy the same span on the graph. 

 

Figure 7 - Linear vs Logarithmic frequency scaling. Two views of the same comb filter. 

This is what we mean when we refer to Linear or Logarithmic frequency scales – how frequencies are plotted 

on charts and graphs. On a linear frequency scale, every interval on the scale spans the same number of Hertz. 

(For example, a graph labeled in 100 Hz intervals). On a logarithmic scale, each span on the scale describes the 

same percent change. A common example is a chart with an octave scale, on which each octave is assigned the 

same span.  

We usually view frequency domain data on logarithmic scales (most often labeled in Third-Octave, Octave, or 

Decade increments) since they correlate better with our perceptions of frequency. However, linear scales are 

very useful for some things as well, such as examining occurrences that are linear in nature like comb filtering 

and distortion harmonics, both of which typically occur every so many Hz. 

When viewing raw FFT data on a logarithmic frequency scale, the trace tends to look fuzzier or busier at higher 

frequencies. This is a natural consequence of plotting data with linearly spaced data points on a logarithmic 

scale: the log scale packs more and more frequencies closer together as frequency increases. This is one of the 

reasons it is common to apply fractional octave banding to spectrum measurement data, and smoothing to 

transfer function data. 

 

DECIBELS 

The decibel (dB) is a logarithmic unit that is used to express the ratio between two values (or a value and a 

reference value). Decibels are commonly used to express amplitudes, voltages, sound pressure, gain and 
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attenuation. Historically speaking, the decibel traces its roots to the Bel, a unit used to express logarithmic 

power ratios in the era of telephone technology (the unit’s namesake is Alexander Graham Bell, commonly 

credited with the invention of the telephone). The knowledge that the decibel is a tenth of a Bel may 

demystify the formulas to some extent, since a Bel represents a power ratio of 10:1, and a decibel is a tenth of 

that.  

Therefore we can express the ratio between two power levels, in dB, by: 

𝑑𝐵 =  10 ∙ log10(𝑃𝑜𝑤𝑒𝑟)  

However, we often wish to express quantities other than power, most often voltage, amplitude, gain, or sound 

pressure. In those cases, since power is related to the square of amplitude: 

𝑃𝑜𝑤𝑒𝑟 =   10(𝑑𝐵 10⁄ )  = 𝐴𝑚𝑝𝑙𝑖𝑡𝑢𝑑𝑒2 

We can restate the decibel formula in terms of amplitude. The mathematical properties of exponents and 

logarithms tell us that we can move the “squared” term to the front of the equation and treat it as a 

coefficient instead, so the 10 becomes a 20: 

𝑑𝐵 =  10 ∙ log10(𝑃𝑜𝑤𝑒𝑟)  =  20 ∙ log10(𝐴𝑚𝑝𝑙𝑖𝑡𝑢𝑑𝑒)  

Since decibels always express a ratio, they must be referenced to something. If no reference is explicitly given, 

the reference is assumed to be one. However, we can express the ratio between two values simply by dividing 

them before taking the log: 

𝑑𝐵 =  20 ∙ log10(𝑣 𝑣0⁄ )  

where 𝑣 is some linear value that you want to convert to decibels and 𝑣0 is a reference value. 

For example, the output of an amplifier is at 20 V while its input is at 0.5 V. We can find the voltage gain of the 

amplifier by: 

𝑑𝐵 =  20 ∙ log10(20/0.5)  

or 32 dB. 

Another common example of this in audio applications is dBu, which references 0 dB to 0.775 Volts  rms. In this 

case you can convert an rms voltag 𝑣 into dBu by: 

𝑑𝐵 =  20 ∙ log10(𝑣 0.775⁄ )  

 

LINEAR VS LOGARITHMIC AMPLITUDE (TIME DOMAIN PLOTS) 

Linear amplitude, as the name might imply, is amplitude displayed on a linear scale. In Smaart, the only place 

you will see this is on a linear time domain chart, where amplitude is displayed as a percentage of full scale. In 

other words, the largest possible (positive and negative) values are scaled to a range of 1 and -1.  

Viewing Impulse Response data on a linear amplitude scale allows us to see relative polarity, and some people 

prefer the linear amplitude scale for identifying discrete reflections in an impulse response. A linear amplitude 
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scale is not as useful for looking at reverberant decay or for identifying peak structures in the low frequency 

range of an impulse response, where the waveform’s period is spread over so much time that a clear impulse 

is not easily discernable. 

 

Figure 8 - Linear vs Logarithmic amplitude scaling. The impulse response of a filter is shown on a linear (percentage of full scale) vs 

logarithmic (decibel) amplitude scale.  

FOCUS 

The concept of focus is a key element in working effectively within Smaart. Since Smaart can display multiple 

graphs at once, and each graph can contain multiple measurements at once, it is important to understand 

which plot or measurement your controls and command will affect.  

Z-ORDER  

When one or more live measurements and/or stored data traces are present on a graph, they can be 

visualized as being stacked on top of each other, not unlike old overhead projector transparencies. Since the x 

axis is the plot’s horizontal axis and the y axis is the vertical axis, the traces stack in the z axis, which you can 

visualize as stacking them on the axis that runs into the display, towards and away from the viewer. 

 

Figure 9 - a visualization of z-order in Smaart, showing how traces are stacked on the graph 

The name of the frontmost trace in the z-axis stacking order (we also call this the top trace) always appears in 

the upper right corner of the graph pane. Clicking in the trace name, or the arrow next to it, will open the Plot 
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Legend which shows all live and stored measurement data displayed in the plot. Click on the name of any 

measurement in the Plot Legend list to bring it to the top of the stack.  

You can also cycle the z order of a graph forward or backward by pressing the [Z] key or [Shift] + [Z] or by using 

the Cycle Z Order Forward and Cycle Z Order Reverse commands in the Command menu. 

PLOT FOCUS 

When multiple plots are present, one of them is always considered the active or focused plot. Clicking 

anywhere within a plot selects it as active, and you can tell which plot is has focus by the thicker plot border 

highlight. When using Smaart’s default light skin, the focused plot will have a thicker black border around it, 

and when using the default dark skin, the focused plot with have a thicker white border around it. You can 

change the color of the plot focus indicator by navigating to the Skins tab of the Options>Preferences dialog 

and choosing a new color for the Plot Area grid border (focused) item.  

 

Figure 10 - an example of Plot Focus in Smaart. Notice how the Phase graph has a thick, dark inner border, indicating focus.  

The focused plot will determine which controls you see in the Control Bar and which set of captured data you 

see in the Data Library (Spectrum or Transfer Function).  

The focused plot is the source for data capture operations – in other words, when you execute the Capture 

command [Spacebar], the live measurement data on the top of the z order in the focused plot is what will be 

captured. The focused plot is also the target for most menu and keyboard commands that affect what you see 

on a graph, such as zoom commands, or cycle z-order commands. 
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ENGINE FOCUS 

Like Plot Focus, you can click on a measurement engine in the Control Bar to give it focus, which is indicated by 

a thicker colored border around the engine and a different shading color on the engine. When a Transfer 

Function engine has focus, it is enlarged to make room for the additional delay controls (Find, Track, and 

Increment/Decrement delay). If a measurement engine’s data is currently shown in a plot, clicking the engine 

to give it focus also brings its data to the top of the z order. 

 

VIEW, DATA, AND P LOT CO NTRO LS 

P LO T VIEW CONTRO LS 

PLOT TYPE CONTROL 

All plots in Smaart follow the same convention for identification and navigation: the upper left corner of each 

plot shows the type of graph (RTA, Spectrogram, Magnitude, Phase, etc). Click the plot label text or the arrow 

next to it to open the droplist and change the plot to a different type.  

 

Figure 11 - Plot Type control droplist 

ADDING / REMOVING PLOTS 

Each plot in Smaart LE has a small [x] icon at the lower left corner of the plot border area. Click this [x] to 

remove the plot from the graphing area. When the graph area is occupied by a single plot, the [x] icon will 

change to a plus [+] icon. Clicking the plus [+] icon will add a second plot to the graph area. Thus, you are able 

to switch between one plot and two plots directly from the graphing area. 

 

Figure 12 - the X icon (left) will remove a plot, and the plus icon (right) will add another  
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VIEW FLYOUT AND VIEW PRESETS 

At the bottom of the Control Bar, just above the Signal Generator, is the View button, which opens the View 

flyout. At the top of the View Flyout are six buttons that control various View settings.  

 

Figure 13 - Control Bar View flyout 

The first two are the “one plot / two plot” buttons used to divide the main plot area into either one or two 

plots. The button labeled with a single rectangle sets the graph area to a single plot, and the button labeled 

with two rectangles splits the graph area into two plots. The rightmost button in the top row toggles the Live 

IR pane when a Transfer Function-type plot (either Magnitude or Phase) is visible.  

The second row of controls will show and hide various sections of the interface: from left to right, the Data 

Bar, the Command Bar, and the Control Bar. (Remember that these elements can also be shown and hidden 

via the View menu at the top of the screen, or via hotkeys.) 

Below the six view buttons is the Presets area, where you can recall the Spectrum and Transfer Function preset 

views as well as ten user-definable view presets by clicking the associated button. The same presets can be 

recalled without opening the flyout by pressing the associated hotkey ([S], [T], or a number from 0 to 9).  

Click the Capture button at the bottom of the flyout to capture the current view configuration, give it a name 

and choose a slot to store it in. The Manage button opens the User Views dialog, where you can capture, 

recall, delete or rename view presets, and reorder the list with the up and down arrow buttons.  
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Figure 14 - User Views dialog 

 You can also recall View Presets and access the User Views dialog from the View > View Presets menu. 

P LO T CONTROLS 

PLOT SCALE 

Smaart LE offers four scaling options for frequency-domain plots (RTA, Spectrograph, Magnitude and Phase): 

three logarithmic options (Decade, Octave and 1/3 Octave, which is the default), and a Linear option as well.  

All three logarithmic options plot the data on a logarithmic frequency scale and simply change the grid ruling. 

The plot scale setting is located in the Graph Settings dialog, which can be accessed by clicking the Gear icon in 

the bottom right corner of the plot border area, or via the Options > Graph Settings menu, or the associated 

hotkeys, [alt] + [S] for Spectrum graph settings and [alt] + [T] for Transfer Function graph settings. See Graph 

Settings for more information on the graph settings dialog. 

 

Figure 15 - Plot Frequency Scale settings, in Graph Options 

ZOOMING  

You can zoom in and out of any graph in Smaart by use of the mouse, hotkeys, or user-definable zoom range 

presets.  

• Press the plus and minus keys ([+] and [-]) on your keyboard to zoom in and out on the y (vertical) axis 

of the active graph.  

• Hold down [Ctrl/Cmd] + [Alt/Option] while pressing plus or minus to zoom in/out on the x (horizontal) 

axis of the active graph.   

• Hold down [Ctrl/Cmd] while pressing plus or minus to zoom both the x and y axis.  
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You can also right-click (or [Ctrl] + click on macOS) and drag with your mouse to draw a “rubber band box” 

around the area you want to zoom in. When you release the mouse button, the selected area will fill the 

entire graph. 

 

Figure 16 - Rubber Band (right-click) zooming 

Remember that you can always click in the border of any plot to restore it to default zoom range. 

Zoom Presets 

Zoom presets enable you to set the x-axis range of a graph (the time or frequency axis) to a predefined range. 

Zoom presets are activated by selecting Zoom > Zoom 1-4 from the Command menu or by pressing 

[Alt/Option] + [1-4] on your keyboard. Selecting Default from the Zoom menu, pressing [Alt/Option] + [5], or 

simply clicking anywhere in the border of a plot will restore it to its default x and y ranges.  

You can customize the zoom presets via the Zoom tab of the Preferences dialog opened via Options > 

Preferences. There are separate settings for Frequency and Time domain plots. Settings in the Frequency 

section define preset zoom ranges for frequency domain plots (RTA, Spectrograph, Magnitude and Phase). 

Settings in the Relative Time section define time ranges for the Transfer Function Live IR display.  
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Figure 17 - Zoom Preferences 

TARGET CURVES 

A target curve in Smaart is simply a line with a specified spectral shape that is drawn on banded RTA displays 

(only) at a specified level. The purpose of a target curve is simply to be visible on the screen as a reference, for 

example when measuring background noise or when attempting to achieve a certain signal spectrum in the 

case of a music mix, speech privacy system, or a cinema sound system’s X curve.  

Target curves cannot be moved up or down the plot in the way that measurement data can. They move up or 

down automatically to accommodate changes in banding resolution, but otherwise their position is fixed. They 

do not appear in the plot legend, and the cursor readout ignores them. Also, target curves are not displayed 

on un-banded spectrum displays, or on transfer function plots. If you need a target curve in a Magnitude plot, 

you can create one by setting an equalizer or processor to the desired response, then simply measuring the 

processor’s response and saving it as measurement data.  

To view and manage available target curves, select Options > Target Curves or use the hotkey [Alt/Option] + X 

to open the Target Curves dialog. For each available curve, you can set the display status, line color and 

thickness. You can also Import new target curves or Delete existing ones from this window. 

Once you have selected target curves for use, open the View menu and select Show Target Curves, or press [X] 

on your keyboard to display the target curves. Note that target curves display at a specific SPL so you may 

need to scroll the RTA plot to see them.  
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GRAPH SETTINGS 

Smaart LE offers a host of options to control and customize graphing. Graph settings in Smaart are accessible 

via the Options > Graph Settings menu and broken into separate tabs for Spectrum and Transfer Function 

graphs. You can also access Graph Settings directly by clicking the Gear icon in the lower right corner of the 

plot border on RTA, Spectrograph, Magnitude or Phase plots.  

Alternatively, open Spectrum Graph Settings by using the hotkey [Alt/Option] + [S], or Transfer Function Graph 

Settings by using the hotkey [Alt/Option] + [T].  

SPECTRUM GRAPH SETTINGS 

The Spectrum Graph Settings dialog is divided into three sections – General Settings, RTA Display Settings, and 

Spectrograph Settings. At the bottom of the dialog is a button to quickly jump to the Spectrum Measurement 

Settings dialog.  

 

Figure 18 - Spectrum Graph Settings 

General Settings 

Frequency Scale controls the x (frequency) axis scaling for RTA and Spectrograph plots. Smaart LE offers four 

scaling options: three logarithmic options (Decade, Octave and 1/3 Octave, which is the default), and a Linear 

option as well. All three logarithmic options plot the data on a logarithmic frequency scale and simply change 

the grid ruling. As explained in Linear vs Logarithmic Plot Scaling, frequency response data is normally 

displayed on a logarithmic frequency axis, however you may wish to view it on a linear axis in certain contexts. 
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Link Plot Banding, which is enabled by default, keeps the in-plot Banding setting linked for all Spectrum-type 

plots (RTA and Spectrograph). Disabling this setting will allow you to set banding independently for each RTA 

and Spectrograph plot using the in-plot control in the lower right of each plot.  

RTA Display Settings 

Banded Data selects whether you want Smaart to display RTA data as a bar chart with fractional octave 

banding, a line graph, or Both. Selecting Both will plot a combination of fractional octave data in bar chart 

form with the raw, un-banded FFT data overlaid as a line graph. Un-banded FFT data is always plotted as a line 

graph (i.e. when the in-plot banding control is set to None).  

 

Figure 19 - RTA Display Settings (Bars, Lines, or Both) 

Peak Hold – RTA data is typically averaged over some period, which helps stabilize the data to make it more 

readable and give an idea of trends over time. Selecting Peak Hold will also display a record of the highest 

level reached by the peaks in the signal at each frequency, or in each band. Peak Hold data is plotted as a 

second line on line graphs, or as a series of flattened bar segments on bar charts. You can also toggle the Peak 

Hold setting via View > Toggle Peak Hold or by pressing the [P] key on your keyboard. When you capture a 

spectrum measurement, both the normal RTA trace and the peak hold data are stored in the captured 

measurement. This means that you can view Peak Hold data in the future even if the setting was not enabled 

at the time of the capture. 

 

Figure 20 - RTA with Peak Hold enabled 

Track Peak will enable a second “crosshair” cursor that tracks the magnitude and frequency of the data point 

with the highest amplitude value in the in the top-most trace on the RTA plot. When your mouse cursor is 
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located in that plot, the cursor readout area will display the magnitude and frequency of the tracked peak as 

well in addition to the usual cursor readout information.  

Peak Type selects the peak hold time. The choices are Infinite or Timed. Infinite peak hold preservers the 

highest peak level recorded for reach frequency until it is either replaced by a higher reading, or you flush the 

averaging buffer ([V] key). Timed peak hold allows the peak trace to decay after some number of seconds, as 

specified in the Hold field.   

Averaged – By default, the peak hold function looks for the highest peaks in each incoming FFT, before the 

data goes into the average for the normal RTA display, meaning that you may never see an averaged RTA trace 

approach the peak levels. If you want to see the highest levels reached by the averaged signal instead, click 

the Averaged check box. 

Plot Calibrated Level applies the input’s calibration offset (if present) to RTA plots and sets the default RTA 

display range from 20 dB to 120 dB. Inputs with a calibration offset present are plotted on the RTA graph in dB 

SPL (positive values). This means that, when this option is selected, plotting a combination of spectrum 

measurements from calibrated and non-calibrated inputs will result in traces being graphed in both the 

positive and negative regions of the vertical scale at once. When this option is not selected, Smaart ignores 

any calibration offsets and plots all spectrum measurements in dBFS (negative values).  

Magnitude Range (dB) sets the default decibel range for the y (vertical) axis of RTA plots. Note that since these 

controls set the default range, it will not have any effect on the plot as currently displayed. Click anywhere in 

the plot border to reset to the (new) default view range.  

Y-Zoom Increment (dB) sets the increment that will be used to zoom the vertical scale of RTA plots when the 

[+] and [-] keys are pressed. 

Y-Scroll Increment (dB) sets the increment that will be used to scroll the vertical scale of RTA plots when the up 

and down arrow keys are pressed.  

Y-Grid Interval (dB) sets the y axis grid ruling interval for RTA plots, in decibels. 

Line Thickness adjusts the thickness, in pixels, of line traces displayed on RTA plots. Thickness for foreground 

(top of z order) and background traces can be adjusted independently.  

Spectrograph Settings 

Slice Height sets the height, in pixels, of each row in the Spectrograph display. Changes will take effect 

immediately. Slice Height can also be adjusted using the [+] and [-] keys while any Spectrograph plot has focus.  

Slices in History sets the maximum number of RTA rows kept in the spectrograph history (in other words, how 

far back you can scroll the plot and still see data). More rows require more memory, especially with large FFT 

sizes, as indicated by the Max Memory Required field.  

Dynamic Range (dB FS) sets the upper and lower thresholds for the spectrograph display, in decibels. Data 

points whose magnitude values fall below the specified Minimum value are displayed in black, and levels that 

exceed the Max value are set to white. The dynamic range can also be controlled by the two arrowhead-

shaped widgets that appear along the left edge of the Spectrograph and RTA plots, see Spectrograph on page 

64. 
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Grayscale changes the spectrograph to use shades of gray, rather than colors.  

 

TRANSFER FUNCTION GRAPH SETTINGS 

The Transfer Function Graph Settings dialog is divided into three sections – General Settings, Magnitude, and 

Coherence. At the bottom of the dialog is a button to quickly jump to the Transfer Function Measurement 

Settings dialog.  

General Settings 

Frequency Scale controls the x (frequency) axis scaling for Magnitude and Phase plots. Smaart LE offers four 

scaling options: three logarithmic options (Decade, Octave and 1/3 Octave, which is the default), and a Linear 

option as well. All three logarithmic options plot the data on a logarithmic frequency scale and simply change 

the grid ruling. As explained in Linear vs Logarithmic Plot Scaling  on page 20, frequency response data is 

normally displayed on a logarithmic frequency axis, however you may wish to view it on a linear axis in certain 

contexts. 

Link Phase & Mag. Smoothing, which is enabled by default, keeps the in-plot Smoothing setting linked for all 

Transfer Function-type plots (Magnitude and Phase). Disabling this setting will allow you to set smoothing 

independently for Magnitude and Phase plots using the in-plot control in the lower right of each plot.  

Line Thickness adjusts the thickness, in pixels, of line traces displayed on Magnitude and Phase plots. Thickness 

for foreground (top of z order) and background traces can be adjusted independently.  

Plot Proportional Graphs expands the Live IR pane to occupy an equal portion of the graph area as the other 

plots, rather than a smaller, fixed-height pane.  

Display Live IR sets whether the Live IR pane is shown whenever a Transfer Function plot type (Magnitude or 

Phase) is displayed. This setting can also be toggled using the Live IR button at the top of the View flyout, or 

via the key command [Ctrl/Cmd] + [I]. 

Magnitude 

Mag Range (dB) sets the default vertical zoom range for Magnitude plots. Note that since these controls set 

the default range, it will not have any effect on the plot as currently displayed. Click anywhere in the plot 

border to reset to the (new) default view range. 

Y-Grid Interval (dB) sets the y axis grid ruling interval for Magnitude plots, in decibels. 

Y-Scroll Increment (dB) sets the increment that will be used to scroll the vertical scale of Magnitude plots when 

the up and down arrow keys are pressed.  

Y-Zoom Increment (dB) sets the increment that will be used to zoom the vertical scale of Magnitude plots 

when the [+] and [-] keys are pressed. 

Coherence 

Show Coherence sets whether Coherence data is displayed for the trace at the top of the z order in Magnitude 

plots. You can also Toggle Coherence via the View menu, or by pressing [C] on your keyboard.  
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1/4 Height vertically compresses the coherence display into the top quarter of the Magnitude plot rather than 

the top half. Selection this option if you want more unobstructed plot space for magnitude traces.  

Coh Blanking Threshold sets the coherence threshold below which magnitude and phase data will not be 

plotted. Frequency data points having coherence values lower than the threshold will not be displayed in the 

plot, however the data is still calculated and captured. In other words, the coherence blanking threshold 

setting has no effect on the underlying measurement data, only whether it is displayed. See Coherence on 

page 68. 

D ATA CO NTRO LS 

SHOWING AND HIDING DATA 

The data shown in Smaart LE’s graphs comes from two places: either Live measurement data that is produced 

by a measurement engine in the Control Bar, or Stored data that was previously captured from a 

measurement engine and is stored in the data library. In the case of Live measurement data, the colored circle 

on the measurement engine controls whether that engine’s data trace is shown or hidden.  

 

Figure 21 - Two Spectrum engines in the Data bar. The Green engine is currently shown, and the Blue engine is hidden, as indicated by the 

X across the colored circle icon 

Clicking the colored circle will hide the engine’s data, which is indicated by the X that appears over the colored 

circle. Clicking again will remove the X and display that engine’s data in the plot, provided of course that the 

engine has data in its buffer to display. Each Live measurement trace displayed in a plot will be the same color 

as the measurement engine that is producing it and will be identified in the Plot Legend by a colored circle 

that matches the colored circle in the measurement engine.  

In the case of stored measurement data, files that are not currently displayed have an X displayed on their file 

icons in the Data Bar. Clicking the colored file icon will display that data in the plot and remove the X to 

indicate that it is shown. Clicking the file icon again will restore the white X and hide the data from the plot. 

You can also use the hotkey [H] to hide the focused trace, or [Ctrl/Cmd] + [Shift] + [H] to hide all stored traces 

displayed in all plots. You can also find these commands in the Command > Stored Data Traces menu.  

You can also hide traces directly from the Plot Legend, by clicking the Hide button to hide the focused trace, or 

by clicking the colored icon (circles for live data and pages for stored data) to hide any trace. 
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Figure 22 - Plot Legend showing a mixture of live data (circle icons) and stored data (page icons) 

You can also quickly show multiple stored traces by holding the [Ctrl/Cmd] key and clicking to select multiple 

traces, or a range of traces by clicking to select the first trace you wish to display, then holding the [Shift] key 

and clicking the last, and then dragging the selected traces into the graphing area. You can also display an 

entire folder of stored data by dragging the folder into the graphing area. 

MOVING TRACES 

When two plots of the type are displayed (for example, two RTA plots), you can move displayed data between 

plots by clicking it in the Plot Legend to give it focus and move it to the top of the z order and then clicking the 

Move button. You can also move the focused trace to the other plot by pressing [M] on your keyboard, or via 

the Command menu > Cycle Preferred Plot.  

In addition, you can double click a measurement engine in the Control Bar to open its settings and then adjust 

the Plot setting between 1 and 2 to choose which plot it displays in by default. Similar, you can access a stored 

trace’s Trace Info dialog, either by right-clicking it in the Data Bar and choosing Info or by using the Info icon at 

the bottom of the Data bar, and setting the Plot setting to either 1 or 2.  

 

Figure 23 - Plot Preference control in the measurement engine config flyout 

TRACE OFFSET 

Smaart allows you to move traces up or down on a graph by applying a trace offset (also referred to as “y-

offset”, “vertical offset” or “dB offset”). You can apply an offset to the focused trace by using the dB + and dB - 

buttons on the command bar, or by the [Ctrl/Cmd] + Up/Down arrow hotkeys. These commands nudge the 

focused trace up or down by the increment specified in the Trace Movement setting of the Options > 
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Preference dialog. The default setting is 1 dB. Another way to move a trace up or down on the graph is to click 

and drag it with your mouse. 

 

Figure 24 - Trace Info dialog showing fields for Plot Preference and dB Offset 

When a trace has an offset applied, the offset amount is displayed in the upper right corner of the plot, below 

the trace name, when the trace has focus. The offset for every trace on a plot is also displayed in the plot 

legend. You can also view and adjust the offset for stored traces using the dB Offset setting in the Trace Info 

dialog. 

 

Figure 25 - Plot Legend showing dB Offset for each trace. 

You can clear the offset for the focused trace by using the [Y] hotkey or Command > Clear dB Offset. Clear all 

offsets for all traces displayed in a plot by clicking the Reset Y± button in the Plot Legend. Clicking the button a 

second time before closing the Plot Legend will restore the offsets. 

Clear all trace offsets at once using Command > Clear All dB Offsets or the hotkey [Ctrl/Cmd] + [Y]. 

TRACE COLOR AND THICKNESS 

You can set the color for live data traces by right clicking the associated measurement engine in the Control 

Bar and choosing Change Color, or by double-clicking the engine to open its settings and clicking the Color 

swatch. You can change the color of stored data by right-clicking and choosing Info, or using the Info button at 

the bottom of the Data Bar, to open the Trace Info dialog, then clicking the Color swatch.  
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In the Color Selection dialog, you can use the color picker to drag the selectors to a new color, or select Red, 

Green and Blue hex values individually, or select a pre-selected color from the palate. Clicking any color in the 

pre-selected color palate will open a menu asking whether you want to use that swatch color as the trace 

color, or re-assign the swatch color to the color value currently indicated by the drag selector and the 

Red/Green/Blue sliders.  

 

Figure 26 - Color Selection dialog 

Alternatively, you can select one or multiple traces in the Data Bar, right click, and choose Assign Random 

Color to quickly re-color them all.  

The thickness of traces displayed in graphs can be adjusted separately using the Line Thickness controls in the 

Spectrum and Transfer Function tabs of the Graph Settings dialog, which you can access by clicking the Gear 

icon in the bottom right corner of the plot border. You can set the thickness, in pixels, for the foreground 

(focused) and background traces independently.  

Z-ORDER  

When one or more live measurements and/or stored data traces are present on a graph, they can be 

visualized as being stacked on top of each other, not unlike old overhead projector transparencies. Since the x 

axis is the plot’s horizontal axis and the y axis is the vertical axis, the traces stack in the z axis, which you can 

visualize as stacking them on the axis that runs into the display, towards and away from the viewer. 

 

Figure 27 - a demonstration of z-order in Smaart 

The name of the frontmost trace in the z-axis stacking order (we also call this the top trace) always appears in 

the upper right corner of the graph pane. Clicking in the trace name, or the arrow next to it, will open the Plot 
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Legend which shows all live and stored measurement data displayed in the plot. Click on the name of any 

measurement in the Plot Legend list to bring it to the top of the stack.  

You can also cycle the z order of a graph forward or backward by pressing the [Z] key or [Shift] + [Z] or by using 

the Cycle Z Order Forward and Cycle Z Order Reverse commands in the Command menu. 

PLOT LEGEND 

The Plot Legend is accessed by clicking in the upper right corner of a plot, either on the name of the displayed 

trace, or the arrow next to it. The Plot Legend lists all traces currently displayed in the plot, both live 

measurements (indicated by a colored circle) and stored data (indicated by a page icon). Each icon is colored 

to match the display color of the corresponding trace in the plot. Clicking anywhere outside the Plot Legend 

will close it.  

 

Figure 28 - Plot Legend showing a mixture of Live and Stored data 

The currently focused trace – the one at the top of the z order – always appears at the top of the list, with a 

shaded highlight. Clicking any on any trace name in the Plot Legend moves it to the top of the list, and to the 

top of the z order in the plot. Clicking the colored icon next to the trace name – the circle for live data and the 

page icon for stored data – will hide that trace from the plot.  

Below the legend are three buttons. The Hide button will hide the trace at the top of the z order. The Reset Y± 

button clears all dB offsets applied to all traces in the plot. While the legend remains open, you can click the 

button again to restore the offsets. When two plots of the same type are visible, the Move button will move 

the focused data to the other plot.  

TRACE INFO 

You can access the Trace Info dialog for any stored measurement data by right-clicking the stored data in the 

data bar and choosing Info, or by selecting the stored data and then clicking the Info icon at the bottom of the 

data bar.  
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Figure 29 - The Trace Info dialog 

The upper portion of the Trace Info dialog lists everything that Smaart knows about the captured 

measurement data, including when it was captured, the name of the measurement engine that produced the 

data and details about the measurement engine’s configuration. It also lists the IO device and input channel 

names used to acquire the measurement signals, and the version of Smaart that captured the data. 

The lower portion of the Trace Info dialog has an editable Name field (be sure to press [Enter] to set the 

change) plus a Comment field for storing any additional information you wish to make note of.  

Clicking the Color swatch opens the Color Picker to allow you to change the display color of the trace. 

The dB Offset field allows you to view and adjust the current y offset applied to the trace, if any. 

Plot sets which plot the trace will appear on, in situations when more than one of the same plot type is 

available, for example, the RTA/RTA view for Spectrum data or the Magnitude/Magnitude view for Transfer 

Function data. When only a single plot of a given type is available, this setting is ignored. See Moving Traces on 

page 35. 

Invert Mag Display appears as an additional option for Transfer Function traces. When enabled, it will display 

the trace’s magnitude response upside down. This can be helpful when setting loudspeaker equalization, as it 

allows a cut to be displayed as a boost, making it easier to see whether the filter response is appropriately 

complementary to the loudspeaker response being equalized. 

Save As will allow you to save a copy of the trace file to another destination on your computer. 

Copy to ASCII copies the data from the selected stored data file to the operating system’s clipboard in tab -

delimited ASCII text format, suitable for pasting into a spreadsheet, text editor, or any other program that 

accepts ASCII text. ASCII exports of spectrum data consist of three columns: frequency, magnitude, peak 

magnitude (as dictated by the Peak Hold options in Spectrum Graph Settings) and column headers. ASCII 

exports of transfer function data include frequency, magnitude, phase and coherence plus column headers. 
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Export to ASCII exports the data from selected file(s) to tab-delimited ASCII text files. You will be prompted to 

choose or create a destination directory for the exported files.  

BAND ING AND SMOO TH ING 

BANDING 

When spectrum data is displayed on a logarithmic scale, it is most often displayed using fractional octave 

banding, which aggregates the signal’s energy into bands that are of constant log width (that is, each band is 

an octave wide, or a third of an octave wide, and so forth). This helps the displayed spectrum correlate well 

with human logarithmic pitch perception, and helps spectrum displays appear in a way that tends to visually 

resemble the tonality of the signal as we perceive it. 

 

Figure 30 - Banded (bars) and unbanded (lines) RTA data displayed on the same plot. Note that the banding is what makes the pink noise 

signal appear "flat" 

In Smaart LE, the banding setting is a display setting – that is, it doesn’t affect the underlying measurement 

data, just how it is displayed. Spectrum data is always captured in full resolution and can then be displayed 

with any banding desired at any point in the future.  

RTA plots can display banded data as a bar chart or a line graph. The Spectrum tab of the Graph Settings 

dialog, which is accessible by clicking the Gear icon in the bottom right of the plot border area, or via Options > 

Graph Settings > Spectrum, or via the hotkey [Alt/Option] + [S], has a Banded Data setting that will allow you 

to choose whether you wish to see Bars, Lines or both. Selecting Both will plot a combination of fractional 

octave data in bar chart form with the raw, un-banded FFT data overlaid as a line graph.  
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Figure 31 - RTA display options: Bars, Lines, or Both 

The banding can be adjusted via the in-plot banding control in the lower right corner of spectrum-type plots 

(RTA and Spectrograph). When the banding control is set to None, the un-banded data is always displayed as a 

line graph. 

By default, the banding settings for RTA and Spectrograph plots are linked, but you can un-link them in 

Spectrum Graph Settings by de-selecting the Link Plot Banding checkbox. 

 

Figure 32 - In-plot Banding Control 

SMOOTHING 

Transfer function data (Magnitude and Phase) is often displayed with some amount of fractional-octave 

smoothing applied, to help illustrate trends and make the data more readable by reducing visual “noise” in the 

measurement, especially when using large FFT sizes that create large numbers of data points.  

In Smaart LE, the smoothing setting is a display setting – that is, it doesn’t affect the underlying measurement 

data, just how it is displayed. Transfer function data is always captured in full resolution and can then be 

displayed with any smoothing desired at any point in the future. 

You can adjust the smoothing applied to traces in Magnitude and Phase plots via the in-plot smoothing control 

in the lower right corner of the plot. By default, the smoothing settings for Magnitude and Phase plots are 

linked, but you can un-link them in Transfer Function Graph Settings by de-selecting the Link Phase & Mag 

Smoothing checkbox.  
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Figure 33 - In-Plot Smoothing control  

C URSO R READOUT 

One of the most important analysis tools in Smaart is the mouse cursor. In addition to operating the programs’ 

controls, the cursor is used to find precise values for any point of interest on any plot. When you position the 

cursor over any data in any plot, the Cursor Readout Area at the top of the graphing area displays information 

about the data under the cursor (amplitude, frequency, or time units depending on the data type).  

 

Figure 34 - Cursor Readout area, displaying Frequency, Wavelength and Magnitude for the data under the cursor 

CURSOR CONTROLS 

Cursor Data Tracking 

Whenever the cursor is positioned within a plot, a “crosshair” appears with horizontal and vertical lines 

extending all the way across the plot. By default, this crosshair will follow the mouse cursor horizontally, and 

snap to the nearest data value on the vertical axis. If multiple traces are displayed, the cursor tracks the 

focused trace (at the top of the z-order). You can turn off data tracking for the moveable cursor by unchecking 

Command > Cursor > Free Cursor Tracks Data or via the hotkey [Ctrl/Cmd] + [Shift] + [F]. Additionally, this 

setting is accessible in the Cursor tab of the Options > Preferences dialog. 

 On spectrograph plots, the moveable cursor crosshair always moves freely in both the x and y axes.  

Locked Cursor 

In addition to the moveable “free” cursor, you can also set a second cursor, called a “locked” cursor, in most 

plot types in Smaart LE (the exceptions are Spectrograph plots and the Live IR pane). When a locked cursor is 
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present, the cursor readout area presents data for both cursors (locked and free) and also displays the 

difference between the two in brackets.  

 

Figure 35 - Locked Cursor behavior. The Locked Cursor data appears in black, the Free Cursor data appears in blue to match the focused 

data, and the differential data appears in [brackets] 

To set a locked cursor, hold [Ctrl/Cmd] and click at the location you’d like to set the cursor to. Alternatively, 

press [Ctrl/Cmd] + [P] or Command > Cursor > Locked Cursor to Peak to set a locked cursor at the highest peak 

in the focused trace. Remove the locked cursor via Command > Cursor > Locked Cursor Clear or the hotkey 

[Ctrl/Cmd] + [X].  

The Command > Cursor menu also offers an option for Locked Cursor Tracks Data, which can also be toggled 

via the hotkey [Ctrl/Cmd] + [Shift] + [L]. This causes the locked cursor to track up and down to different 

amplitude / magnitude values at the same frequency as the data beneath it changes. Additionally, this setting 

is accessible in the Cursor tab of the Options > Preferences dialog. 

READOUT OPTIONS 

Smaart LE offers several options to customize what information is displayed in the Cursor Readout Area. These 

settings are located in the Cursor tab of the Options > Preferences dialog.  

The Cursor Frequency Readout setting controls what is displayed when the cursor is located in a frequency 

domain plot (RTA, Spectrograph, Magnitude, or Phase).  

• Frequency displays only frequency in Hertz for the data under the cursor position 

• Frequency & Wavelength displays frequency in Hertz and the corresponding wavelength in feet or 

meters, depending on the temperature and distance units selection specified in the General tab of 

the Preferences dialog 

• Frequency & Note ID displays frequency in Hertz and the closest musical note corresponding to that 

frequency 

The Cursor Time Readout setting controls what is displayed when the cursor is located in a time domain plot 

(Live IR).  

• Milliseconds displays the time coordinates in milliseconds only 

• Milliseconds & Distance displays the time coordinates as milliseconds and as equivalent distance, 

based on the Speed of Sound setting in the General tab of the Preferences dialog 
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• Milliseconds & Samples displays the time coordinates as milliseconds and equivalent number of 

samples based on the IO device’s current sampling rate 
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C APTURING AND HAND LING D ATA 

THE D ATA BAR 

The Data Bar, which resides along the left side of the program window, is dedicated to accessing and 

managing stored measurement data.  The Data Bar is essentially a window into the Documents\Smaart 

LE\Data folder on your computer’s hard drive where captured traces for the active plot type are stored. 

You can hide or show the data bar by: 

• Toggling the Data Bar entry in the View menu 

• Clicking the corresponding button in the View flyout (first button in the second row) 

• Using the hotkey [B] 

• Clicking the Data Bar button which is assigned by default to the Command Bar 

When the Data Bar is hidden, a disclosure arrow appears along the left side of the interface. Click the arrow to 

show the Data Bar.  

The data bar shows only one type of stored data at a time – either stored spectrum data when a spectrum-

type plot (RTA or Spectrograph) has focus, or transfer function data when a Magnitude or Phase plot has 

focus. The heading at the top of the data bar tells you which type of data files are currently shown. 

 

Figure 36 - the Data Bar 
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Each stored trace visible in the data bar has an icon colored to match the display color for the trace data. An X 

appears over the icon for data that is not currently being displayed in a plot.  

You can organize stored data in the data bar using folders and drag-and-drop operations much as you would in 

any file system window on your computer, and you can drag files and folders from the data bar onto a plot to 

display them.  

There is always one folder “pinned” to the top of the Data Bar – this is the Session Folder, and it is the 

destination for any captured measurement data or new folders created during your measurement session. 

You can create a new session folder by clicking the three-line (hamburger) menu button at the top of the data 

bar and choosing New Session Folder. You can also drag an existing folder to the top position in the Data Bar to 

make it the new session folder. If you haven’t done this before, Smaart will pop up a messaging asking you if 

you wish to do so. Creating a new session folder automatically creates folders for both Spectrum and Transfer 

Function data, while changing the session folder via drag and drop only applies to the current data type.  

At the bottom of the data bar are two buttons. The button with the Info icon is used to open the Trace Info 

dialog for a selected data file. See Trace Info on page 38. The button with the Trash Can icon will delete any 

selected files or folders and their contents. The deleted files will end up wherever deleted files go on your 

computer’s operating system, whether that’s the Trash for macOS or the Recycle Bin on Windows.  

The three-line (“hamburger”) menu at the top of the data bar opens a menu with many commands for data 

management. See Data Bar Menu on page 47. 

 

 

C APTURING D ATA 

At any time, you can capture data being produced by a measurement engine to store it in your data library. 

The most common way to capture data is by pressing [Spacebar], but you can also use the Command > Stored 

Data Traces > Capture or press the Capture button that appears by default on the Command Bar. 

When Capture is executed, Smaart will capture the output of the measurement engine on the top of the z 

order in the active plot. A Capture Trace pop-up window will display a default name for the captured data 

based on the name of the measurement engine that generated it. Press Enter or click OK to keep the default 

name or type the name you wish and then press Enter. The saved trace will appear in your Session Folder 

inside the data bar. 

 

Figure 37 - Capture Trace dialog 



3 – Controlling Smaart and Viewing Data 
 

Smaart LE User Guide 47 Release 9.1 

Measurement data is always captured directly at full resolution, regardless of the current banding or 

smoothing settings, so that those parameters can be adjusted later without any changes to the raw underlying 

measurement data.  

Note that the measurement data is captured at the time Spacebar is pressed – you can take as long as you like 

to name the trace, the measurement data has already been captured. 

You can use a Capture All command ([Shift] + [Space]) to capture the output of all measurement engines that 

are running, visible in the Control Bar, and displaying data in a plot (not hidden). The Capture All command is 

also found in the Command > Stored Data Traces menu and is assigned to the Command Bar by default.  

When a Capture All is executed, a Capture Group pop-up window will display a default name for the folder 

that will hold all the captured traces. Press Enter or click OK to keep the default name or type the name you 

wish and then press Enter. A folder with the desired name will be created in the Data Bar containing all the 

traces that were captured. 

D ATA FO LDER STRUC TURE 

Smaart LE produces two main types of stored measurement data - .srf files are saved Spectrum measurement 

data, and .trf files are saved Transfer Function measurement data. Inside the Documents\Smaart LE\Data 

folder, you will find folders labeled Spectrum and Transfer Function which hold captured .srf and .trf data, 

respectively. The Data Bar within Smaart is a “live view” of these two folders, so renaming or deleting a saved 

measurement inside the Data Bar will do so inside the Data folder as well. The converse is also true. 

D ATA BAR MENU 

Clicking the three-line (hamburger) menu at the top of the Data Bar opens a menu containing a number of 

data operations.  

 

Figure 38 - Data Bar hamburger menu 

Hide All hides all stored traces currently visible in the graph area. 

Copy to ASCII copies the data from the selected stored data file to the operating system’s clipboard in tab -

delimited ASCII text format, suitable for pasting into a spreadsheet, text editor, or any other program that 

accepts ASCII text. ASCII exports of spectrum data consist of three columns: frequency, magnitude, peak 
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magnitude (as dictated by the Peak Hold options in Spectrum Graph Settings) and column headers. ASCII 

exports of transfer function data include frequency, magnitude, phase and coherence plus column headers. 

Export to ASCII exports the data from selected file(s) to tab-delimited ASCII text files. You will be prompted to 

choose or create a destination directory for the exported files.  

Save As saves a copy of the selected trace to some location other than the Data Library. Selecting this 

command opens a Save Trace As dialog that will let you browse your computer’s file system and select where 

you wish to store the data. 

New Session Folder creates new session folders for both Spectrum and Transfer function files, to act as the 

destination for any newly captured measurement data. Selecting this command pops up a dialog box asking 

you for a Folder name. When you click OK, new session folders with the specified name are created in both 

the Spectrum and Transfer Function subdirectories of the Documents\Smaart LE\Data folder. 

Recapture replaces the data in the selected trace data file with fresh measurement data captured from the 

focused live measurement engine in the focused plot. 

Rename allows you to change the name of a selected file or folder in the data library. Press [Enter] to set the 

new name. 

Average will allow you to create an average from stored data. See Averaging Stored Data. 

New Folder creates a new empty folder inside your current session folder.  

New Folder from Selection is enabled when one or more saved data files are selected. This command creates a 

a new folder in the Session Folder and moves the selected items into it, after which the name of the new 

folder is automatically selected for editing so you can simply start typing to rename it. Remember to press 

[Enter] to set the change.  

Import Trace does the same thing as File > Import > Trace Data File. It can be used to import stored data files 

from other locations on your computer into your Smaart data library, and can convert legacy .ref files from 

older versions of Smaart, Smaart Pro or SmaartLive into .srt or .trf files. Note that the Import Trace dialog only 

shows you trace files matching the current type shown in the Data Bar (Transfer Function or Spectrum). Legacy 

.ref files can be either type, so if you select a .ref file for import and nothing happens, try switching the 

focused plot type. Note also that Smaart cannot important legacy reference group .rgp files from Smaart Pro 

or SmaartLive, only individual .ref files. 

Assign Random Color will give all selected traces a random trace color. If you don’t like the results, you can run 

the operation again, or of course select a color you like in Trace Info. 

Open File Location opens the folder where the selected data is stored on your computer’s hard drive. This is 

useful for when you want to quickly copy saved measurement data to another location or sent it to a friend. 

Refresh Data Library forces Smaart to re-read the contents of its data library folder. If you have made any 

changes to files or folders in the Data Library from outside of Smaart – for example, by sorting and renaming 

files using your operating system’s file explorer – while Smaart is open, you can use the Refresh Data Library 

command to make sure Smaart picks up the changes.  
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DATA BAR CONTEXT MENU 

The context menu that appears when you right-click any file or folder in the Data Bar is mainly a sub-set of the 

commands detailed above, with two additional items: Info opens the Trace Info dialog for the selected data 

file (see Trace Info on page 38)  and Delete, which will delete the selected folders and / or files, and behaves 

the same way as the delete function within your computer’s operating system. The deleted files will end up 

wherever deleted files go on your computer’s operating system, whether that’s the Trash for macOS or the 

Recycle Bin on Windows.  

 

Figure 39 - Data Bar right-click menu 

AVERAGING STO RED D ATA 

If a folder and/or multiple saved data files are selected, Smaart will offer to average the selected traces, 

including all traces contained within any selected folder. To multi-select files and folders in the Data Library, 

you can hold down the [Ctrl/Cmd] key on your keyboard while clicking with your mouse, or hold down the 

[Shift] key to select a contiguous group of traces. If a single data file is selected or there is no selection, 

choosing Average will open the full version of the trace averaging dialog, where you can select individual trace 

files you wish to contribute to the average. 

In either case, you can entire a name for the averaged trace in the Name field, and choose to use either 

decibel (dB) or Power averaging. In the case of transfer function averages, you have the additional option of 

applying Coherence Weighting to the average, and in the case of spectrum averages, you have the option of 

applying normalization. These are the same options available for live averages. See Spatial Averaging on page 

76 for more information. 

The Color field will allow you to choose the display color for the trace. Once you click OK, the new averaged 

trace data will immediately appear in your session folder in the data bar, and on the focused plot in the 

graphing area. 
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Figure 40 - Trace Average dialog 

IMPO RTING AND EXPO RTING D ATA 

You can import stored measurement data into Smaart by using the Import Trace function in the Data Bar 

hamburger menu, or File > Import > Trace Data File. It can be used to import stored data files from other 

locations on your computer into your Smaart data library, and can convert legacy .ref files from older versions 

of Smaart, Smaart Pro or SmaartLive into .srt or .trf files. Note that the Import Trace dialog only shows you 

trace files matching the current type shown in the Data Bar (Transfer Function or Spectrum). Legacy .ref files 

can be either type, so if you select a .ref file for import and nothing happens, try switching the focused plot 

type. Note also that Smaart cannot important legacy reference group .rgp files from Smaart Pro or SmaartLive, 

only individual .ref files. 

Alternatively, you can simply use your operating system’s file browser to place stored measurement data in 

the Documents\Smaart LE\Data folder, choosing the appropriate subfolder, either Spectrum or Transfer 

Function. This is a quick way to import large data sets and nested folders. If you are using your operating 

system’s file browser to import or organize data while Smaart is open, you may wish to use the Refresh Data 

Library function in the Data Bar’s hamburger menu to ensure that Smaart picks up on the changes. 

Data export in Smaart LE is handled via the Data Bar hamburger menu, or by right-clicking on the saved trace 

data directly. There are several options available: Copy to ASCII, Export to ASCII, and Save As. 

Copy to ASCII copies the data from the selected stored data file to the operating system’s  clipboard in tab-

delimited ASCII text format, suitable for pasting into a spreadsheet, text editor, or any other program that 

accepts ASCII text. ASCII exports of spectrum data consist of three columns: frequency, magnitude, peak 

magnitude (as dictated by the Peak Hold options in Spectrum Graph Settings) and column headers. ASCII 

exports of transfer function data include frequency, magnitude, phase and coherence plus column headers. 

Export to ASCII exports the data from selected file(s) to tab-delimited ASCII text files. You will be prompted to 

choose or create a destination directory for the exported files.  

Save As saves a copy of the selected trace to some location other than the Data Library. Selecting this 

command opens a Save Trace As dialog that will let you browse your computer’s file system and select where 

you wish to store the data. 

Alternatively, you can simply use your operating system’s file browser to locate stored measurement data for 

sharing to another computer. Stored measurement data is located in the Documents\Smaart LE\Data folder 
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on your computer. To open a file browser window directly to the data in question, right-click the stored data 

in the data bar and choose Open File Location.  

 

THE SIGNAL GENERATO R 

The signal generator is the only component within Smaart LE that generates output signals. The signal 

generator can generate a variety of test signals and has a number of options. When the signal generator is 

activated, it will output the desired signal on all outputs on all devices that are currently selected in Output 

Config.  

If you haven’t selected any output device channels for use, the signal generator will display a popup message 

letting know that it couldn’t start. Clicking the Configure button in this popup will bring you to the Output tab 

of IO Config to make your device and channel selections. See Initial Configuration – Selecting Outputs on page 

17. 

CO NTRO L AREA 

The Signal Generator controls inhabit the bottom row of the Control Bar, where a button labeled with the 

current signal type selection acts as the On / Off, and will glow red when the signal generator is running. You 

can also turn the generator on and off using the [G] hotkey. The + and – buttons adjust the generator level, 

which is displayed in the level field. Clicking within the level field opens the Signal Generator settings. 

 

Figure 41 - Signal Generator control bar controls 

SIGNAL GENERATOR D IALOG 

In the bottom left of the signal generator dialog is the Output Config button which will bring you to the Output 

tab of the IO Config dialog, so you can select output channels for the generator to use if you haven’t done so 

already. 

In the upper left of the signal generator dialog is a Signal drop down that allows you to select the type of 

signal. Choices are Pink Noise, Sine, Dual Sine, and File. Some of the available options displayed will vary 

depending on what signal type is selected. 

Stop Gen after Capture turns the generator off as soon as a Capture or Capture All command is executed. This 

allows you to minimize the amount of time the generator is on by turning it off as soon as the required data 

has been acquired.  

Fade In enables a gentle ramp up to the desired level each time the generator is turned on. 
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Figure 42 - Signal Generator dialog 

Signal levels for all generator output signals are displayed relative to normalized full scale peak, meaning that 

the maximum possible amplitude value is 0 dBFS. 

SIGNAL TYPES 

PINK NOISE 

Smaart can generate two basic types of pink noise, which we refer to as Random and Pseudorandom. Random 

pink noise is created by streaming the output of a random number generator through a digital filter network, 

much the same way that most hardware pink noise generators work.  

Pseudorandom noise signals in Smaart repeat on intervals that are power-of-two samples in length up to 219 

(512K samples)1. Although both random and pseudorandom noise will give effectively comparable results for 

the general real-time transfer function measurements produced by Smaart LE, pseudorandom noise has some 

mathematical advantages when dealing with more advanced measurement features such as sync-source 

measurement found in other versions of Smaart. However, pseudorandom noise also offers the advantage 

that it can be band-limited to fit a specific measurement application. 

When measuring with pseudorandom noise, you should always select a cycle length that is at least aslong as 

the longest FFT time constant used in your measurement. Since the longest time constant used in MTW is 

approximately 1 second, 64K would be the lower limit at 48 kHz sample rate. However, it repeats so often that 

it may become annoying to listen to. For real-time measurements in general, a setting of 512K or 1024K is 

generally a good choice.  

There are three spectral options for pseudorandom noise: broadband pink noise, band-limited pink noise, and 

speech weighted noise. Pink noise has a spectrum that appears flat on an RTA using fractional octave banding, 

and rolls off at 3 dB per octave / 10 dB per decade on an un-banded display. Bandlimited pink noise has the 

same nominal spectrum across a specified bandwidth. Checking the Band Limited option enables the Start 

Freq and Stop Freq controls, enabling you to specify your desired passband.  

 
1 Technically, the random number generator is pseudorandom also, however, given its length of 219937 samples it will 
effectively never repeat. 
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Figure 43 - Signal Generator dialog showing Pseudorandom Pink Noise controls  

Speech Weighted noise is pseudorandom noise with a spectral shape based on the idealized long-term 

idealized average speech spectrum (LTASS) defined in ANSI S3.5-1997. 

All noise signals are calibrated to normalized full scale, which means the maximum possible amplitude value is 

0 dBFS. Random and pseudorandom noise signals are hard limited to ensure a peak-to-RMS ratio of 12 dB. 

SINE AND DUAL SINE 

The options for Sine signals and Dual Sine signals are essentially identical. Selecting Sine just removes the 

bottom row of controls that is visible when Dual Sine is selected. The relative signal level for each tone (Level 1 

and Level 2) is set independently, and the master Level control controls the overall signal level. 

 

Figure 44 - Signal Generator dialog showing Sine and Dual Sine controls 

Signal levels for all generator output signals are displayed relative to normalized full scale peak, meaning that 

the maximum possible amplitude value is 0 dBFS, and the maximum RMS level would be – 3 dBFS. 

FILE 

File allows you to use  any .wav or .aiff file as a test signal. When using file-based signals, simply specify the file 

you wish to use by clicking the Browse button and then specify the output level. When Normalize is selected, 

Smaart will scale the signal to a peak level of 0 dB normalized full scale. Note that the signal is sent identically 

to all outputs. If the source file is stereo, only the left channel is used, and the right channel is ignored. Also, 

be aware that Smaart copies the entire file into RAM to provide seamless lopping, so you may want to keep 

the file lengths fairly short. 
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Figure 45 - Signal Generator dialog showing File controls 

SKINS 

Smaart has two built-in color schemes, the Default Dark scheme that you see the first time you run the 

program, and a Default Light scheme that uses dark text against a lighter background. Default Dark works well 

indoors, particularly in darkened rooms. Default Light might be a better choice in brightly lit environments, or 

when making screenshots for printed documents or presentations.  

You can change between them using the View > Skins menu, cycle through all available skins using the hotkey 

[Ctrl/Cmd] + [Shift] + [X].  

In addition to the built-in defaults, Smaart also allows you to define custom color schemes (“skins”) via the 

Skins tab of the Options > Preferences dialog.  

 

Figure 46 - Skins Preferences 

The Skins tab is divided into two sections, Color Picker and Skin Manager. The Color Picker section consists of 

color tiles showing the color assignments for various interface elements in the current color scheme. Each 
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color tile is a button that opens a Color Selection dialog. Color changes take effect immediately when you click 

Apply in the color selector. 

The Skin Manger section lists all available color schemes. Since the Default Light and Default Dark skins can’t 

be altered, making a change while one of them is the active skin will create a New Custom Skin using either the 

Default Light or Default Dark skin as a starting point. You can rename a custom skin by double-clicking it in the 

list and typing a new name. Custom skins update with any changes in real time. The Restore Defaults button 

will restore all colors in the custom skin to match either the Default Light or Default Dark skin on which it was 

based. Save As will save a copy of the skin with a new name. Load will select a skin for use, and Delete will 

delete the custom skin. 

Custom skins are stored in the Documents\Smaart LE\Skins directory as .xml files, so you can move them to 

other computers or share them with friends by placing the files in this folder. 

 

INPUT METERS 

Smaart’s Input Meters dialog is accessible via View > Input Meters or [Shift] + [E]. The dialog displays an input 

meter for each input that is selected for use in the Input tab of IO Config. The device and input Friendly Name 

are displayed for each, along with a polarity invert button. If the IO device supports Smaart’s gain tracking 

feature (Roland OctaCapture and Audient EVO series), additional controls are displayed for phantom power 

and preamp gain.  

 

Figure 47 - Input Meters, showing additional gain and +48V controls available when using Roland OctaCapture or Audient EVO hardware 

You can toggle the orientation of the input meters between vertical and horizontal via View > Input Meters 

Orientation or [Shift] + [Alt/Option] + [E].  

AP I 

Smaart LE includes an API which allows the sharing of real time measurement data to third-party programs 

and devices, such as system processors and filter design software programs. In Options > Preferences > API, 

you can click the Enabled checkbox to start the API running and make Smaart’s measurement engine data 

streams available at the IP / Hostname / Port specified in the settings. The Status indicator turns green to 

indicate the API is running.  
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ADVANC ED SETTINGS 

In Smaart LE, a single setting is available in the Options > Preferences > Advanced tab. Allow Multi-Device TF 

enables you to select your measurement and reference channels from different input devices when 

configuring transfer function measurement engines. Although this is sometimes helpful in specialized 

situations, it is generally best avoided, as measuring across devices can cause clock drift in the measurement, 

which can render phase, Live IR data and measurement delay times useable. If your application requires multi-

device transfer function measurement, you may wish to contact Rational Acoustics support for assistance.   



4 – Fundamental Measurement Concepts 
 

Smaart LE User Guide 57 Release 9.1 

4 – FUNDAMENTAL MEASUREMENT CONCEPTS 

In this section you will find an overview of the fundamental measurement concepts that are critical to the 

fruitful operation of Smaart in the field. While we strive to provide a functional level of context, the reader is 

encouraged to supplement their study of these topics with additional works dedicated to measurement and 

analysis. A list of recommended resources is found in the Appendix.  

QUESTIO NS AND VIEWPOINTS 

Conceptually, a measurement provides an answer to a question. The nature of the question being asked will 

dictate choice of measurement and workflow. Thus, the first step in a fruitful measurement process is to 

clarify for yourself the question that you’re asking. A conceptual understanding of the measurement tools 

available in Smaart will be your guide. 

SIGNAL ANALYSIS VS SYSTEM RESPONSE ANALYSIS: SINGLE VS DUAL CHANNEL 

MEASUREM ENTS 

All measurements taken with Smaart fall into two broad categories: single-channel (signal analysis) and dual-

channel (response analysis). Understanding the differences between the two, and when to use each type of 

measurement, is of paramount importance to using Smaart effectively. Both single- and dual-channel 

measurements are powerful tools when applied properly. Conflating or confusing the two, however, can lead 

to poor decisions based on incomplete or incorrect information. 

WHY ARE THEY USED? WHAT DO THEY TELL US? 

Single-channel measurements ask the conceptual question “What do we have?” In the simplest terms, they 

display information about a signal, hence the term “signal analysis”. Spectrum measurements are signal 

analysis measurements because they simply display the frequency content of a signal. In Smaart, Real -Time 

Analyzer (RTA) and Spectrograph displays are created with single-channel FFT analysis. 

Another type of single-channel measurement in Smaart LE is sound pressure level (SPL) measurement. When 

using a calibrated measurement setup, SPL measurements can tell us about the sound levels that are 

occurring at a point in space (wherever the measurement microphone is located).  

A good rule of thumb is that we should use single-channel measurements to answer questions about the 

properties of a signal itself. We might use a single-channel measurement to investigate “How much 1 kHz 

energy is in that signal,” “what is the frequency of that feedback tone,” or “what is the sound level at this 

position in the venue?” 

Dual-channel measurements, by contrast to signal channel measurements, are comparative measurements. 

They compare two signals to find the similarities and differences between them. In Smaart LE, transfer 

function measurements are dual-channel measurements that are used to compare the output signal of a 

device or system to the input signal that produced it. Dual-channel measurements therefore ask the 

conceptual question “what effect does this device or system have on the signals passing through it?”  

Since we know what went in and what came out, we can determine what happened in between – and also 

when. Transfer function measurements allow us to precisely measure time relationships between the two 

signals, enabling us to examine phase relationships and find delay times for signal moving through systems. 
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We use the term “measurement signal” to refer to the signal that appears at the system’s output, and the 

term “reference signal” to refer to the signal that was sent into the system – acting as the basis for 

comparison, hence the term “reference.” The transfer function measurement then displays the results of this 

comparison in a variety of ways. 

A good rule of thumb is that we should use dual-channel measurements to answer questions about the 

response of a system, or in other words, to study how a system affects the signals passing through it. We 

might use a dual-channel measurement to investigate “What is the crossover frequency of this system”, “How 

much attenuation is this equalizer providing at 1 kHz,” or “What is the latency of this processor?” 

 

Figure 48 - Single-Channel vs Dual-Channel measurement 

TIME DOMAIN VS FREQUENCY DOMAIN ANALYSIS 

The “domain” of a graph refers to the independent variable, or conceptua lly, the context in which the signal is 

occurring. For example, an audio waveform is a time-domain signal, because the signal level (be it voltage, 

digital amplitude, or sound pressure) varies over time. If we wanted to make a graph of the audio waveform, 

we would normally put time on the horizontal (x) axis and amplitude on the vertical (y) axis.  

Frequency domain analysis of a signal, on the other hand, shows the energy content of the signal over 

frequency. In this case, we usually put frequency on the horizontal (x) axis and signal level on the vertical (y) 

axis. 

In Smaart, we can study both signals and system response (single- and dual-channel measurement data) in 

both the time and frequency domains simultaneously. The ability to see both representations at once at once 

is key to maximizing our understanding what we are measuring.  
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WHY ARE THEY USED? WHAT DO THEY TELL US? 

When an audio signal (time domain) is transformed into the frequency domain, we can view the spectrum of 

that signal, or in other words, its energy content over frequency. This is helpful, for example, when examining 

the tonal content of a mix or identifying feedback frequencies. 

In sound system analysis, a time domain view of a sound system’s response (known as the impulse response) 

shows the arrival time of energy passing through the system, including any reflections and reverberation that 

might be problematic. System response in the frequency domain (transfer function) shows us the tonal 

response of the system (magnitude trace) and the phase relationship over frequency (phase trace), which 

taken together allow us to learn how the system will affect the signals passing through it. We’ll discuss how to 

read and interpret system response measurement data in a following section. 

THE MEASUREMENT “FO UR SQUARE”  

We can now classify all measurements produced by Smaart two different ways – a measurement is either 

single channel or dual channel, and its data can be displayed either in the time domain or the frequency 

domain. The figure below illustrates this classification: the top row shows single-channel (signal analysis) in 

both time domain (waveform, left column) and frequency domain (spectrum, right column). The bottom row 

is similar but shows a system response measurement in the time domain (impulse response, left column) and 

frequency domain (transfer function, right column).  

 

Figure 49 - The measurement "four square", showing time domain in the left column and frequency domain in the right column. Single -

channel in the top row and dual channel in the bottom row 
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BRO AD BAND VS BAND LIMITED 

Broadband measurements are a look at the entire bandwidth of the captured signal – the overall level in the 

time domain, which corresponds to having the full spectrum of data available in the frequency domain. 

However, in some cases it is useful to apply band-limiting to a measurement, which allows us to focus on 

energy in a particular frequency range. For example, when working with Impulse Response measurements, 

Smaart provides the ability to apply a band-limiting filter to the impulse response data, which can allow us to 

discern the arrival time and overall time-domain behavior of energy in a certain frequency band.  

Another example of band-limited measurements is the ability to measure SPL in octave bands, which offers a 

more granular look at sound pressure level information over frequency than the traditional broadband 

weightings. 

SPL / BROADBAND METERS 

There are several places throughout Smaart’s interface – named, input configuration and measurement 

engines – where meters display the incoming digital signal level in dBFS. Signal levels below -60 dBFS are 

shown in dark green, transitioning to lighter green between -60 and -12 dBFS, then yellow from -12 to -6 dBFS 

and red above -6. Since the meters are calibrated to normalized full scale peak, the maximum possible level is 

0 dBFS. If a clip is detected on any input channel, the entire meter will turn red until the overload condition is 

resolved. 

 

Figure 50 - Input meter with color key 

At the top of the Control Bar, there is a docked level meter, which can instead display a clock. Any input that 

has been selected for use within Smaart can be selected from the dropdown menu and its level in dBFS 

displayed on the meter. For inputs that have been calibrated for SPL measurement, an additional selection of 

sound level metrics can be chosen as well.  

THE FOURIER TRANSFO RM – THE ENGINE TH AT POWERS THE ANALYZER 

At the heart of modern audio analysis lies the Fourier transform, a set of mathematical operations that are 

used to transform audio signals between the time domain and frequency domain.2 The Fourier transform is 

named for 19th century French mathematician and physicist Jean-Baptiste Joseph Fourier, and is based on the 

idea that complex signals (such as music or speech) can be mathematically “deconstructed” and broken down 

into their component frequencies – sine waves of varying levels and time relationships (magnitude and phase). 

In Smaart, Fourier transforms are used to calculate and display the spectral content of time domain signals. 

 
2 Of course, Fourier transforms are also used in many applications outside of audio, such as image processing. 
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Figure 51 - a conceptual representation of the Fourier Transform, which breaks a complex time domain signal into its frequency 

components 

TIME -FREQUENCY RELATIO NSH IP S 

Working with discrete Fourier transforms (DFT or FFT) involves a key tradeoff that centers around the size of 

the FFT. The “chunk” of signal that gets fed into the transform is called the Time Record , or Time Constant, or 

Time Window. Using a longer time record increases the frequency resolution of the measurement, and allows 

the measurement to accurately resolve lower frequencies, but this comes at the cost of time resolution – all 

the signal’s energy within the time record gets “lumped together,” leaving us unable to distinguish between 

multiple events such as musical notes or syllables that might occur within the same time record. 

We might decide to use smaller FFTs to increase time resolution and see individual rhythmic events, but this 

decreases frequency resolution, making it harder to resolve individual musical pitches, and so forth. This 

mathematical relationship can be elegantly described with the formula 𝑇 = 1/𝑓 where 𝑇 is time in seconds 

and 𝑓 is frequency in Hz or cycles per second.  

𝑇𝑖𝑚𝑒 𝐶𝑜𝑛𝑠𝑡𝑎𝑛𝑡 =  
𝐹𝐹𝑇 𝑆𝑖𝑧𝑒

𝑆𝑎𝑚𝑝𝑙𝑒 𝑅𝑎𝑡𝑒
=  

1

𝐹𝑟𝑒𝑞𝑢𝑒𝑛𝑐𝑦 𝑅𝑒𝑠𝑜𝑙𝑢𝑡𝑖𝑜𝑛
 

 

If desired, this formula can be rearranged for frequency resolution. 
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𝑇𝑖𝑚𝑒 𝐶𝑜𝑛𝑠𝑡𝑎𝑛𝑡 =  
𝐹𝐹𝑇 𝑆𝑖𝑧𝑒

𝑆𝑎𝑚𝑝𝑙𝑒 𝑅𝑎𝑡𝑒
=  

1

𝐹𝑟𝑒𝑞𝑢𝑒𝑛𝑐𝑦 𝑅𝑒𝑠𝑜𝑙𝑢𝑡𝑖𝑜𝑛
 

 

For example, let’s say we want to perform an FFT on a time-domain signal so we can study its spectrum. If we 

use a 16K FFT (the default for spectrum measurements in Smaart), and our sample rate is 48 kHz, it will take 

about 341 milliseconds to acquire those 16,384 samples (16384/48000 = 0.3413̅).  

Both the lowest frequency data point and the spacing of the frequency data points are dictated by the fact 

that our FFT has a time record of 341 milliseconds. 𝑇 = 1/𝑓 tells us that our first data point (“bin”) will be at a 

frequency of about 2.9 Hz (1/0.3413), and that frequency bins will be spaced about every 2.9 Hz. (The second 

data point will be at approximately 5.8 Hz, the third at approximately 8.9 Hz, and so forth.) If we want to 

increase our frequency resolution, and extend it to lower frequencies, we need to use a longer time constant 

(larger FFT).  

 

Figure 52 - the relationship between FFT size and frequency resolution 

D FT, FFT AND IFT 

DFTs are somewhat computationally intensive, but in 1965, a new method for more efficient calculation, 

called the fast Fourier transform (FFT), made it possible to calculate the transform very quickly.3 This paved 

the way for modern audio analysis, in which a typical laptop computer can continuously calculate multiple 

FFTs and display the results to the user in real time. The FFT commonly requires the “chunk” of signal being 

analyzed to contain a number of samples equal to a power of 2, for example, 4096 (“4K”), 8192 (“8K”), 16384 

(“16K”) and so forth.  

 
3 The FFT is commonly attributed to James W. Cooley and John W. Tukey’s 1965 paper “An algorithm for the machine 
calculation of complex Fourier Series.” Though the method had been discovered years earlier by mathematicians including 
Karl Gauss, it wasn’t practical to execute until the advent of modern computers.  
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The Inverse Fourier transform (IFT) – is used to reconstruct time-domain signals from spectral data. This 

bidirectional relationship between time and frequency domains allows a wide range of possibilities for signal 

processing and analysis, since the signal can be transformed, processed and displayed in whichever domain is 

more helpful given the task at hand, and what we are hoping to learn from the measurement. 

COMP LEX D ATA 

The DFT and FFT mathematics take in a discrete time domain signal and produce a series of complex data 

points in the frequency domain. Complex data means that each frequency data point (“bin”) is described by a 

pair of numerical values, or complex coordinates. Termed “real” and “imaginary”, the pair of coordinates can 

indicate a location on a two-dimensional plane such as a graph or a map. 

Complex coordinates can be stated as rectangular coordinates or as polar coordinates. Rectangular 

coordinates indicate the data point in an (X,Y) format, and is familiar to anyone who has done some graphing 

in math class. Alternatively, the same data point can be indicated in polar format as a vector, with one number 

indicating the distance from the reference point (Magnitude), and the other indicating the angle of rotation 

(Phase). Since we graph the magnitude and phase data on two separate plots, it might appear that they are 

two unrelated quantities, but in reality they are each telling us half of the entire mathematical reality, which is 

described by the combination of both the Magnitude and Phase data at each frequency. 

When we look at spectrum data on an RTA or Spectrograph plot, we are seeing the magnitude half of the 

complex data, with no indication of phase. When a dual-channel measurement is produced, the complex data 

in the measurement and reference signals is compared to produce the relative phase data that forms the basis 

for the phase trace displayed in Smaart.  

SPEC TRUM MEASUREMENTS (SINGLE CHANNEL)  

Spectrum measurements produce information about the energy distribution in a signal – that is, which 

frequencies are present in the signal, and at what levels. Spectrum measurements are useful when we want to 

study a signal’s tonality, identify resonances and feedback, or want a visual confirmation of what we’re 

hearing at a location. In Smaart, the RTA and Spectrograph plots are both spectrum measurements. 

RTA 

The real-time spectrum analyzer, or RTA, is a familiar tool to most audio professionals and probably needs 

little introduction. It enables you to see frequency content of signals moment-by-moment in real time. 

Essentially, the RTA is a graph of the energy in an incoming signal, broken down by frequency or frequency 

ranges, with frequency in Hertz on the x axis and magnitude on the y axis in decibels. The graph is updated 

continuously whenever at least one spectrum engine is running, to produce a real-time display. By adjusting 

the scale and averaging of the display, we can refine the “look and feel” or responsiveness of the 

measurement to suit different tasks. The RTA is the audio measurement that most closely corresponds with 

the human hearing mechanism, which explains its near omnipresence at mix position at live events.   

Banding 

Fractional octave banding aggregates all the data points within a given bandwidth (one octave wide, 1/3 

octave wide, 1/12 octave wide, etc) into a single level for that band. Banding can serve to illuminate overall 
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trends in the data, and, when displayed on a logarithmic frequency axis, produces a display that “looks like it 

sounds.” In other words, the fractional octave banding correlates better with human hearing perception. 

Banding is a display parameter for spectrum measurements, not an inherent part of the underlying 

measurement data. Spectrum measurement data is always calculated, captured and stored at the original FFT 

resolution, and the banding can be changed after the fact without altering the stored measurement data.  

 

Figure 53 - Fractional-octave banding vs raw FFT data on a logarithmic frequency scale. The lighter green bars show the 1/12 octave 

banded RTA measurement of pink noise. The darker green line shows the un-banded view of the same data. The banding is what makes 

the pink noise appear “flat” 

SPEC TROGRAP H 

Smaart’s spectrograph straddles the time and frequency domains, offering a view of how the frequency 

content of a signal changes over time. The spectrograph expands upon the utility of the RTA by displaying a 

scrolling display of continuous spectrum measurement “slices”. You can think of it like a “top down” view of 

the RTA, where the color indicates the height of each bar. In the realtime mode spectrograph, frequency is 

across the horizontal (x) axis, time scrolls vertically (y axis), and level is indicated by color. In Impulse Response 

mode, the horizontal (x) axis indicates time, as is true for the other Impulse Response plot types where time 

runs from left to right. Frequency is on the vertical (y) axis and level is indicated by color.  

 

Figure 54 - Spectrograph Dynamic Range control widgets 
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THE TRANSFER FUNCTIO N (DUAL CH ANNEL) 

The transfer function measurement is a dual-channel measurement that is created by comparing the output 

signal of a device or system to the input signal that produced it. Dual-channel measurements therefore allow 

us to study how a device or system affects signals that pass through it.  

The two inputs that are compared to produce the transfer function measurement are called the Reference 

Signal and the Measurement Signal. The reference signal is the signal that is sent into the system as the basis 

for comparison, while the measurement signal is captured at the output of the system. An FFT is then 

performed on both the measurement and reference signals, and the resulting complex data is used to 

generate the views of the system response. 

THE VIEWS O F THE SYSTEM RESPO NSE 

The system response can be described and displayed in a number of ways, each providing unique insight. 

Taken together, we receive a wholistic understanding of the system under test. There are four components to 

a transfer function measurement displayed in Smaart: Magnitude, Phase, Coherence, and Live IR.  

MAGNITUDE 

The transfer function Magnitude graph shows relative gain and attenuation in the response of the system 

under test at each frequency. If the reference and measurement signals are identical in level at all frequencies, 

the magnitude trace is a flat line at 0 dB. If there is an overall level difference between the two signals, that 

flat trace will move up or down on the graph. Up means the measurement signal is coming in at a higher level 

than the reference signal (system output higher than system input), and down means the opposite. If the 

system under test (SUT) produces relative gain at some frequencies and relative attenuation at others (as is 

the case with real world sound systems, equalizers, and so forth), the magnitude trace will deviate above the 

centerline of the measurement at frequencies where there is a relative gain, and dip below it in the regions of 

attenuation. 

PHASE 

The transfer function Phase graph shows the phase portion of the frequency response of the system under 

test (SUT). Phase is plotted with frequency in Hertz on the x axis and phase in degrees on the y axis. Phase, or 

phase shift, is a measure of the relative time relationship between two signals as a function of frequency, 

expressed in terms of cycle time. Like the Magnitude plot, the slope of the phase trace is flat when the refence 

and measurement signals are identical and arrive at exactly the same time.  

With a few exceptions, the key to reading the phase trace is not to focus on the degree values themselves, but 

instead to pay attention to the slope of the trace.  

• When the phase trace slopes upward, energy in the measurement signal is arriving before energy in 

the reference signal. 

• When the phase trace flattens out, that represents that the two signals are arriving at the same time. 

• When the phase trace slopes downwards, energy in the measurement signal is arriving after energy in 

the reference signal. 

If you simply remember and internalize these three simple points, you will be able to easily decipher phase 

data in the field. 
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Figure 55 - Uniform (linear) delay on a linear frequency scale. 

When there is a uniform time offset between otherwise identical signals (perhaps measuring a digital 

processor that is set to bypass, so it simply reproduces the input signal at unity gain after a brief processing 

delay), the phase trace is a straight line on a linear frequency scale. When it is sloping upward or downward at 

a constant rate of change, steeper slopes correspond to greater time offsets.  

On a logarithmic frequency scale, the straight line becomes a curve and the wraps become more tightly 

packed as you ascend in frequency, but the information is the same.  

 

Figure 56 - the same phase traces shown on a logarithmic frequency axis 

The phase trace “wraps” – that is, runs off the top or bottom of the graph periodically and reappears on the 

opposite side – because we are viewing cyclical data that spans 360° on a flat graph, so we have to have an 

edge somewhere (not unlike how a map of the world has to have an edge somewhere).  
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If you imagine cutting out the phase graph and gluing it to a paper towel tube, you will see that the phase data 

is inherently cyclical in nature. We cut the tube somewhere and flatten out the plot so we can read it. Out of 

convention, we split the plot along the 180° line, so 0° spans the centerline of the plot and 180° is at the top 

and bottom edge. If you click in the phase plot and use the Up and Down arrow keys on your keyboard, you 

can “roll” the phase trace to see its cyclical nature. This would be like taping the paper tube back together  and 

slicing it at a different point. 

Conceptually, the phase trace is like a clock that only has a second hand. Such a clock can’t directly tell us how 

many minutes have elapsed, but we can discern that information by counting how many times the second 

hand sweeps around. In the same way, we can’t discern time offset by looking at the phase value at any single 

frequency. By looking at the relationship between multiple data points – the slope of the line – we can begin to 

see the telltale signs of time offset.  

For example, let’s say our measurement and reference signals are offset in time by 25 milliseconds. At 20  Hz, 

that 25 millisecond offset corresponds to half a cycle (180°). At 40 Hz, the same time offset corresponds to a 

full cycle (360°), but 80 Hz, 160 Hz, 320 Hz, and other multiple frequencies also complete full cycles in that 

amount of time. Since our phase trace only spans a 360° interval (-180° to 180°), we could expect any 

frequency that has completed one or more complete cycles to have a value of 0°. The phase trace would 

therefore be wrapped (the telltale indicator of time offset) and pass through 0° at 80 Hz, 160 Hz, 320 Hz, and 

so forth. We have much more useful information from looking at the entire trend of the trace than by trying to 

look at individual data points.  

Up until now, we have been discussing phase shift in terms of two otherwise identical signals arriving at 

different times, but of course most things that we measure with Smaart do more to an input signal than 

simply delaying it. When audio signals flow through the System Under Test, they are typically filtered in some 

way – that is, the resulting signal well have more energy than the input signal at some frequencies, and less at 

others. You can think of transducers, loudspeakers, and even entire sound systems as bandpass filters. All of 

these devices allow energy that falls within some frequency range to pass, while energy outside that range is 

significantly attenuated. 

In physical systems, any process that affects the spectral content of a signal also affects its timing. In other 

words, you cannot change magnitude response without also changing phase response.4  

With the sole exception of symmetrical FIR filters, we can expect that all analog and digital filters, along with 

any other process that affects the frequency content of a signal, such as air loss or acoustical reflection – to 

produce an asymmetric impulse response. That is, they all affect the timing of the signal differently at 

different frequencies. The phase response of a bandpass filter, for example, typically leads at some 

frequencies, lags at others, and is in-time in between, so when you need to align two bandpass filters in a 

system – whether it’s two drivers, two cabinets, or two entire subsystems – there probably won’t be any 

single right answer that works at all frequencies. You’ll have to choose a frequency range where  you want the 

two systems to align, which is where the phase display comes in handy. 

 
4 At this point, astute readers may wonder how linear-phase FIR filtering fits into this puzzle. No laws of the universe have 
been violated, however, and T = 1/f remains in effect: changing the signal in the frequency domain has an effect in the 
time domain as well – in the form of delay. Linear-phase FIR filters are designed with a symmetrical impulse response that 
induces the same amount of phase shift forward and backward, so the phase shift in the back half of the filter effectively 
cancels out the phase shift in the front half. The price to be paid is an overall delay time as the IR peak is shifted back in 
time, which limits the applicability of FIR filters in live sound reinforcement environments, particularly at low frequencies.  
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COHERENCE 

Coherence is a statistical evaluation of the causality or linearity between the reference and measurement 

signals in a transfer function measurement. You can think of it as a data quality indicator. Coherence can 

detect contamination of the measurement signal by unrelated signals such as background noise or 

reverberation, and it is sensitive to timing mismatches as well. We use it in Smaart to gauge the quality of 

transfer function measurement data for every frequency data point in real time.  Since some of the factors 

that negatively impact coherence (noise and reverberation) also negatively impact speech intelligibility, the 

coherence trace serves as a useful indicator of system intelligibility as well.  

The coherence calculation essentially asks the question “How much of the energy we are seeing in the 

measurement signal at this frequency was caused by the reference signal?” The answer is a number between 

0 and 1, which Smaart displays as a percentage. A value of 100% indicates perfect correlation between the 

two signals and zero means there is no discernable relationship between them.  

In Smaart, the coherence display is plotted in the upper portion of the Magnitude graph, with frequency on 

the x axis and coherence as a percentage value between 0 and 100 on the y axis. Coherences is always 

calculated for all transfer function measurements but is only displayed for the topmost trace in the graph – in 

other words, the trace whose name appears in the upper right corner of the plot. This could be a live 

measurement or a stored trace, whichever is currently at the top of the z order. 

The little arrowhead-shaped widget pointing at the coherence scale on the right side of the Magnitude graph 

sets the threshold for the coherence blanking function. Coherence blanking removes questionable data from 

magnitude and phase traces at any frequency for which coherence does not meet or exceed the specified 

threshold. You can click and drag the widget up and down with your mouse to change the threshold. 

Alternatively, you can change the numerical value in the Coh Blanking Threshold (%) box in Transfer Function 

Graph Settings. Coherence blanking works for all displayed traces, not just the one on the top of the z order, 

and it works even if the coherence trace is not displayed. 

 

Figure 57 - The red trace across the top of the Magnitude plot is the Coherence trace. Note the vertical scale displayed in the upper right 

of the plot. 

Causes of Poor Coherence 

There are three main factors that are the most common causes of a drop in coherence. 

The first is a problem with the measurement or the measurement system. A timing mismatch between the 

measurement and reference signals will manifest as a drop in coherence if the timing mismatch is a significant 
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fraction of the measurement time window. Small timing mismatches might not be very visible when using 

large FFT sizes. When the coherence trace is generated from a Multi-Time Window (MTW) FFT array, as it is in 

Smaart LE, timing mismatches cause coherence to drop first at high frequencies, since the highest frequencies 

use the shortest time windows, and larger time offsets extend the drop to lower frequencies, creating a 

characteristic “stair step” pattern that is a tell tale sign of measurement delay not being properly set. 

The second cause of low coherence is environmental noise. Any components of the measurement signal that 

are uncorrelated with the reference signal (background noise, HVAC, construction noise, people talking near 

your measurement microphone, etc) will have a negative impact on coherence. The solutions are to either 

measure at a higher level (to increase your advantage over the noise), or find a way to reduce the background 

noise (by shutting off the HVAC systems or asking the people talking near you microphone to take a break). 

Using more averaging will probably not increase the overall coherence but it can have a stabilizing effect on 

the coherence trace. 

The third cause of low coherence in a measurement is reverberation. If you have ruled out issues with your 

measurement system, and coherence does not improve when you measure louder, the likely culprit is 

reverberation. Reverberation is a non-linear phenomenon but increased proportionally when the excitation 

sound pressure is increased – measuring louder will not improve the direct-to-reverberant sound ratio. There 

typically isn’t much you can do about it, and it’s important to remember that a low-coherence measurement 

in a reverberant space isn’t a bad measurement, it’s an accurate measurement of a reverberant space.  

There is an additional, “special case” cause of coherence drops is the presence of distortion products in the 

measurement signal, for example, if a system under test is non-linear and outputting a distorted signal. In that 

case, since the distortion products contribute to the overall energy at certain frequencies, we would see a 

drop in coherence at those frequencies because the signal to noise ratio has been degraded. Although this is 

unlikely to be observed in typical real-world measurement conditions (as the level of distortion would have to 

become quite severe and audibly objectionable before it caused a discernible difference in the coherence 

data), it is often visible under controlled circumstances (test environments that eliminate the three usual 

causes of low coherence), such as the AES75-2022 standard for measuring loudspeaker maximum linear levels 

using noise.  

LIVE IR 

The Live IR pane shows the impulse response of the system under test – the time domain representation of its 

frequency response – continuously recalculated in real time. The Live IR graph shows time in milliseconds on 

the x axis and amplitude / magnitude on the y axis. When the plot is set to Lin (Linear), amplitude is shown as 

a percentage of digital full scale (values between 1 and -1). When the plot type is set to Log or ETC, magnitude 

is shown in decibels.  

The center point of the time axis is determined by the current measurement delay setting of the transfer 

function engine being displayed. For stored traces, the center point of the time axis corresponds to the 

transfer function engine delay setting at the time the data was captured.   

The logarithmic (Log) view is probably the most familiar to anyone who is accustomed to looking at acoustical 

impulse responses or IR reverb plugins. The view shows arrival time of the direct sound and the following 

reverberant decay, plotted on a y axis in decibels. 
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The linear (Lin) view is useful for identifying discrete reflections and can reveal polarity. For example, If you 

measured two loudspeakers with matched magnitude responses but unmatched polarity, you would note that 

the prominent peaks in the linear Live IR view would point in opposite directions. 

The ETC view (Energy Time Curve, also sometimes called the Envelope of the impulse response) represents the 

magnitude of the energy arrival over time by ignoring phase. The textbook description is that the ETC data is 

the real impulse response combined with its Hilbert transform (a copy roated 90° in phase). In more practical 

terms, ETC view tends to fill in the zero crossings seen in the Log view of the IR, producing a display that is 

easier to read. 

 

Figure 58 - A comparison of the ETC and the impulse responmse with linear and logarithmic amplitude scaling 

The Live IR pane is only shown when at least one frequency domain transfer function plot is visible (Magnitude 

or Phase). The pane is hidden when there are no Magnitude or Phase type plot displayed, and also when it is 

hidden by deselecting the Live IR button in the View flyout. Alternatively, this setting can be toggled by checking 

or unchecking the Display Live IR checkbox in Options > Graph Settings > Transfer Function. 

The Live IR data is calculated independent of the frequency domain transfer function data and so is not affected 

by the Averaging Depth setting in the Control Bar. In Smaart LE, the Live IR is calculated using an 8k FFT with 4 

FIFO averaging. 
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MEASUREM ENT ISSUES 

MEASUREMENT SIGNALS AND SOURCE INDEPENDENCE 

Although there exist other mathematical methods by which transfer function data can be derived, the dual-

channel method has a unique advantage in that it allows the system response to be measured using any 

suitably broadband signal material. The measurement therefore does not require any specific or particular test 

signal to be used – the reference signal simply acts to provide a copy of whatever is being sent into the 

system, so it can be compared against the measurement signal. This means that a dual-channel measurement 

can be produced using many varieties of noise, music or other signals. This property is termed “source 

independence” or “signal independence”. Conceptually speaking, the analyzer does not care what signal is 

being passed through the system, as long as it is provided a copy. 

The obvious qualification is that the signal being used must contain sufficient energy at the frequencies of 

interest to produce a measurable output form the system at those frequencies. For example, a recording of a 

flute playing or a soprano singing is not a good choice when measuring subwoofers, because those signals 

contain very little energy in the subwoofer range. For this reason, pink noise remains a popular choice for real 

time dual channel transfer function measurement due to its spectral density – you don’t have to wait very 

long for your measurement to fill in because pink noise consistently contains energy at all frequencies.  

WHAT’S IN YOUR MEASUREMENT LOOP?  

It’s important to understand that transfer function measurements can only tell us about the system’s response 

in the portion of the signal path that we choose to measure. For example, if we tapped our reference signal 

from the mixing console’s output, any processing that happens to the signals before they leave the console 

would not show up in our measurement, and the console itself would not be considered part of the system 

under test (SUT) in that configuration. Therefore, we must choose our signal tap points very carefully based on 

what we are trying to measure, and we must always be aware of what is, and what is not, included in our 

measurement loop. 

DELAY COMPENSATION 

Delay compensation is a crucial factor in transfer function measurement. The reference signal for the 

measurement, regardless of source, is typically connected directly to our audio interface either electronically 

or digitally, meaning that it travels through a piece of wire to the input of the measurement system, and 

arrives virtually instantly. The measurement signal, on the other hand, is the output signal of the system under 

test, so it is subject to delay from filtering, latency, processing, any intentionally added alignment delay, and of 

course – in the case of acoustical measurements – propagation delay, or the time it takes for the sound wave 

to travel from the loudspeaker through the air to the measurement microphone, which happens at the speed 

of sound. 

All of this can introduce time offset – potentially tens of milliseconds – between the reference signal and the 

measurement signal, and since our goal is to compare the two signals, we must compensate for that offset 

inside Smaart by delaying the reference signal to match the arrival time of the measurement signal. Every 

transfer function measurement engine in Smaart has a built-in delay line just for that purpose. Delay times for 

each transfer function engine are displayed in the small numerical field immediately to the right of the 

engine’s input signal meters. 

Smaart includes mechanisms to automatically determine and compensate for delay in the measurement loop. 
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Delay Finder  

The Delay Finder is activated by clicking the Find button on the focused transfer function engine in the Control 

Bar, via Command > Activate Delay Tracker or the hotkey [L]. The measurement engine should be running and 

the signal meters on the measurement engine should show reasonable signal levels for measurement and 

reference inputs to the engine. The Delay Finder window appears and Smaart runs the measurement 

procedure and displays its results when finished. 

 

Figure 59 - The Delay Finder dialog 

If the measured delay time seems reasonable and you are happy with the results, click the Insert button to set 

the active transfer function engine to the determined delay time and close the dialog. You can also click Find 

Delay to run the measurement again or Cancel to close the dialog without changing engine delay time. The 

Advanced button opens the Advanced Delay Finder (see below).  

The ETC checkbox tells Smaart to use the Envelope Time Curve of the impulse response to locate the peak 

energy arrival, rather than the linear IR itself. This will often result in a slightly different delay time, and one 

may provide a better answer than the other in a given situation.  

You can set the FFT size and number of averages for the basic and advanced delay via the Delay Finder control 

group in Options > Measurement Settings > Transfer Function.  The default is a 64K FFT with no averaging, 

which works out to a time constant of 1365 ms at 48k sampling rate. This is sufficient for finding delay times at 

distances up to about 450 feet (140 meters) from a source – a good rule of thumb is that the FFT time 

constant should be least three times greater than the expected delay time. When measuring from extremely 

long distances or using a sample rate greater than 48k, you may need to increase the FFT size. When working 

in very noisy surroundings, increasing the number of averages may help as well. 

 

Delay Tracker 

Smaart’s delay tracking feature is designed to keep transfer function measurements aligned in situations 

where the delay time may change from moment to moment, for example in windy conditions, when the 

microphone is being moved, or if the PA is swinging. It can also be uses as a quicker way to set measurement 

delay under well behaved measurement conditions when the new delay value is within about 50 milliseconds 

of the current value. 
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Figure 60 - Delay Tracker controls. The Track button in the focused measurement engine will activate the delay tracker for that engine, a s 

will the circle icon to the right of the delay field. The Track button at the top of the control bar near the measurement controls activates 

Tracking for all transfer function engines. 

The small circle to the right of the delay time field in the measurement engine indicates the status of the Delay 

Tracker. The circle is gray when the tracker is off, turns yellow while it’s running (momentary), and red when 

it’s locked on (latched).  

Click the tracker circle once to activate it momentarily – the circle will turn yellow, and the tracker will run 

until it has successfully found the proper measurement delay time. Once it’s gotten the same delay value 

three times in a row, it turns itself off. Double-click the tracker circle to latch it on – the circle will turn red, and 

it will continue tracking the delay time until you turn it off. 

Advanced Delay Finder 

Clicking the Advanced button in the basic Delay Finder dialog opens the Advanced Delay Finder window. 

 

Figure 61 - The Advanced Delay Finder window 
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 The Advanced Delay Finder window is resizable and “modeless,” meaning it can stay open while you work in 

other Smaart windows. The most obvious feature of the advanced delay finder is that it shows you a graph of 

the IR measurement instead of just telling you the peak time. The graph type selector in the upper left corner 

gives you a choice of linear (Lin), Log or ETC plot type. The cursor readout above the plot shows the fixed 

cursor coordinates on the left, movable cursor coordinates in the center and the delta between the two on the 

right. You can move the fixed cursor position by holding down the [Ctrl/Cmd] key on your keyboard while 

clicking on the graph with your mouse and the found delay time will change to match the new position.  

Clicking the Filter button in the upper right corner of the graph runs a one-octave bandpass filter on the IR, 

centered on the frequency specified in the text entry field to the right of the button – this might be the 

crossover frequency between two systems that you want to align or any other frequency that you would like 

to isolate.  

The control group in the lower left corner of the window presents the same information as the basic Delay 

Finder window. An IR measurement runs automatically when you open the Advanced Delay Finder window 

but you can re-run the measurement at any time by clicking the Find button. The Insert button inserts the 

found delay time as the reference signal delay for the selected transfer function measurement signal pair. 

 Clicking the Store button adds the found delay time to the table to the right. The table below the graph is a 

relative delay time calculator. Checking the T0 box next to any entry designates it as the time zero reference 

and recalculates all of the relative delta (Δ) time and distance 

The TF Pair selector to the right of the table enables you to select another transfer function signal pair to 

analyze. Note that changing this selection automatically re-runs the IR measurement. The level meters show 

you measurement and reference signal levels for the selected input signal pair. The Close button closes the 

window. 

AVERAGING – A PO WERFUL DATA ANALYSIS TOO L 

Averaging is a powerful method for stabilizing measurements, emphasizing trends, and suppressing noise. 

There are two types of averaging within Smaart: temporal and spatial. Both help highlight what is consistent 

and suppress the variance in a group of measurements. Spatial averaging highlights trends over a physical 

area, and temporal averaging helps reveal consistency within a series of measurements taken from the same 

location.  

TEMPO RAL AVERAGING 

Temporal averaging means averaging a measurement over some period of time. When taking acoustic 

measurements, there is often a significant amount of noise mixed in with the signal we are trying to measure, 

which can make each “frame” of measurement differ from the one before it. This causes the readings to 

fluctuate and jump around on the screen. We would refer to this noisy, hard-to-read trace as an “unstable” 

measurement.  

Smaart is a real-time audio analyzer, so it will keep measuring until we tell it to stop. When these successive 

frames of measurement are averaged together, the signal components are reinforced, while the random noise 



4 – Fundamental Measurement Concepts 
 

Smaart LE User Guide 75 Release 9.1 

tends to average itself away.5 This has the effect of stabilizing the measurement, making it smoother and 

easier to read.  

The tradeoff is in responsiveness. Measuring a system response in a highly reverberant environment might 

require more averaging to stabilize the measurement, but changes we make to the system settings, such as 

equalization or delay, will take longer to be reflected in the measurement, as new data and old data are 

averaged together. 

One important thing you can do to speed up the process when measuring in a noisy environment is to press 

the [V] key after making a change to the system. This flushes the averaging buffers and resets the average, 

causing the measurement to immediately repopulate with current data. This way, you don’t have to wait for 

the older data to fall out of the average before you see the result of your changes. 

For electronic measurements, very little averaging is typically required, as noise is not often a significant issue. 

For acoustic measurements, more averaging is usually required to help stabilize the trace against the 

contributions of noise and late reverberant energy. 

 

POLAR VS COMPLEX 

Since transfer function data is complex in nature (see Complex Data on page 63) there are two mathematical 

approaches to averaging the magnitude data: Polar and Complex. Polar averaging calculates decibel 

magnitudes at each frequency for each incoming measurement frame, and then takes a moving average of the 

result. Complex averaging keeps two separate running averages of the “real” and “imaginary” parts of the 

complex signal, and then calculates magnitude and phase from those averages.  

Although these two treatments are equally valid from a mathematical standpoint, they can produce slightly 

different results in various measurement conditions. Polar averaging (sometimes called RMS Averaging) tends 

to be more stable in adverse measurement conditions such as in the presence of wind, HVAC air currents or 

swinging loudspeakers, and will allow more reverberant energy into the measurement. Complex averaging 

(sometimes called Vector Averaging) has better noise immunity in general and tends to exclude more 

reverberant energy from the measurement.  

In favorable measurement conditions, the difference tends to be rather minimal, however the option can be 

set independently for each transfer function engine, so it is easy to compare them in real time, to see if one 

gives you a better answer than the other does in a given situation. 

FIFO VS INTEGRATING 

There are two different averaging methods used in Smaart’s temporal averaging – FIFO and Integrating - that 

produce different time domain “ballistics”.  

A FIFO (First In First Out) average, also known as a Simple Moving Average, always averages together some 

number of the most recent measurement frames with equal weight. The oldest frame falls out of the 

measurement when a new frame comes in, hence the name. If you set up an RTA and clap your hands near 

 
5 When two successive frames of measurement are averaged, since the signal is correlated with itself, it sums coherently 
(+6 dB) while the noise is not, and only increases by 3 dB. Thus each doubling of the number of averages will theoretically 
increase the signal to noise ratio of the measurement by 3 dB.  
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the microphone, a FIFO average will cause the level to jump up and remain high until the clap energy falls out 

of the averaging buffer, then the display will drop back down. 

An exponential integrating average, sometimes called “Time Weighting”, is produced by averaging the current 

measurement frame, with a certain weighting factor, into all the data that’s currently in the averaging buffer. 

Therefore it could be said that newer data has more weight in the average. Conceptually, you might think of 

an exponential integrated average as how it takes some time to charge a capacitor, for your furnace to warm 

up your house, or for a boat to turn after the rudder is changed. The system is always tending towards the 

new state, but it has some “momentum,” so it takes time to catch up. Another example of this behavior is the 

natural damping effect of the needle on a VU meter.  

Spectrum engines in Smaart LE offer the following averaging settings: 

• None is no averaging, and each measurement frame is displayed in sequence. 

• Fast mimics the behavior of the SPL Fast integration on sound level meters, which has a time constant 

of 0.125 seconds. 

• Slow mimics the behavior of the SPL Slow integration on sound level meters, which has a time 

constant of 1 second.  

• Infinite is infinite averaging, which integrates continuously until the averaging buffer is flushed.   

Transfer Function engines in Smaart LE offer the following averaging depths: 

• 1 = 2 FIFO 

• 2 = 4 FIFO 

• 3 = 8 FIFO 

• 4 = Slow 

• 5 = 1 Sec 

• 6 = 2 Sec 

• 7 = 3 Sec 

• 8 = 5 Sec 

• 9 = 7 Sec 

• 10 = 9 Sec 

• Inf = Infinite 

 

 

SP ATIAL AVERAGING 

While temporal averaging averages measurements taken from a single location over time, spatial averaging 

averages measurements taken at different locations. This is useful to help separate system response from 

localized anomalies occurring at single locations. Spatial averaging answers the question “what is the trend 

between these positions?” 
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DB VS POWER AVERAGING 

Smaart offers two choices for averages: decibel magnitude (dB) or Power. The distinction lies with what type 

of data is used to calculate the average. Decibel averaging (sometimes called arithmetic averaging) is a simple 

average of the decibel magnitude values at each frequency. Power averaging is an average of the squared 

linear magnitude values at each frequency, with the result converted to decibels.  

Conceptually, dB averaging produces a result in which all the contributors are equally weighted – you might 

say that it creates more of a “consensus” view, whereas power averaging gives more weight to the 

contributors with higher levels. In the context of evaluating sound system frequency response, power 

averaging works best if all the measurements being averaged are similar in level. Otherwise, its natural bias 

towards higher magnitudes means that any measurement that is significantly higher in level than the others 

will tend to dominate the result. In a dB average, the higher-level measurement won’t affect the overall result 

more than any other contributor. 

Practically speaking, the one advantage of power averaging in this context is that its bias towards the higher 

magnitudes means that it will de-emphasize the contributions from nulls when averaging data containing 

comb filters. The nulls of a comb filter are much deeper than the peaks, and so can produce dips in a dB 

averaged response that might look concerning although they might be largely inaudible to a human listener at 

any single location.  

In Smaart, decibel averaging is the default because we find that it tends to give helpful and useful results in 

the widest variety of applications, but you can also choose to generate a power average instead – or better 

yet, generate both and see if one gives you a better answer in a given situation. 

Normalized Power Averaging 

Normalized power averaging attempts to sidestep the limitations of power averaging in magnitude response 

measurements by ensuring that all data traces going into the average are approximately equal in overall level 

before calculating the average. It works by calculating a single-figure decibel average of all frequency data 

points within a given frequency range for each trace being averaged and then adjusting the overall level of 

each trace so that their average level within that range is identical.  

Transfer function power averages are adjusted so that their average decibel magnitudes for the range of 225 

Hz to 8.8 kHz are all 0 dB. When averaging transfer function data, we can assume in advance that we want an 

averaged magnitude response (as opposed to an average level) and we have a natural reference point (0 dB) 

to adjust the levels to and so no additional intervention is required. The caveat is that you are also assuming 

that the system under test has significant energy within the normalization frequency range and if that is not 

true, e.g., when measuring a subwoofer, you may not get the expected result. In that case, a dB average with 

coherence weighting may be a better choice.  

Normalized RTA power averages work similarly to transfer function power averages except that Smaart cannot 

assume in this case that you want a normalized average; there isn’t a natural reference point to adjust the 

levels to, and the normalization range is different. Normalized RTA power averages use 125 Hz to 4 kHz as the 

normalization range to better accommodate cinema systems and in this case, you must designate one of the 

traces or measurements being averaged as the reference level. 
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LIVE VS STATIC 

In Smaart, there are two ways to create spatial averages. They can be generated from saved measurement 

data, for example if you move a microphone around the space to capture a series of measurements, and then 

average them together to see the trend. Alternatively, spatial averages can be generated in real time by using 

multiple microphones.  

P ROTECTING TH E AVERAGING BUFFER – IMP ROVING D ATA 

Smaart’s measurement calculation pipeline includes a number of methods designed to  keep bad or 

questionable data out of the averaging buffers, off the screen and out of your decision-making processes. 

These include Magnitude Thresholding, Overload Protection, and Signal Presence Detection.  

MAGNITUDE THRESHOLDING 

Magnitude thresholding is Smaart’s base-level defense against invalid transfer function data. Conceptually, if 

we did not put anything into the system under test at a given frequency, we should not be getting anything 

out. Smaart looks at every frequency data point in the reference signal, and for any frequency bins where the 

level falls below the specified magnitude threshold setting, those bins are omitted when calculating that 

measurement frame. Bins that fail the thresholding test are simply not updated, and so if a certain bin still 

contains valid data from a previous measurement frame, Smaart leaves it alone. Frequencies that have never 

cross the threshold since the measurement began simply remain blank. 

This means that, for example, if you were taking a transfer function measurement using music as a test signal, 

the measurement would continuously only update at those frequencies at which the music has energy at any 

given time. 

OVERLOAD PROTECTION 

If Smaart detects three or more consecutive samples with maximum (0 dBFS) amplitude in either the 

reference or the measurement signal, it assumes that clipping has occurred and will stop updating transfer 

function measurement data until the overload condition has subsided. 

DELAY TRACKER 

The Delay Tracker can continuously adjust the measurement delay in realtime in situations where it may 

change from moment to moment, such as with air movement, wind, or swinging loudspeakers. See Delay 

Tracker on page 72. 

LIVE IR SIGNAL PRESENCE DETECTION 

Signal presence detection for the Live IR is similar to magnitude thresholding for the frequency-domain 

transfer function measurement data. In this case, however, Smaart simply stops processing the Live IR 

measurement when the reference signal falls below threshold. Smaart will keep checking the input level and 

resume processing once the reference signal is re-acquired.  
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CO RRECTIO N, CALIBRATIO N, AND COMP ARISON 

M IC ROPHO NE CO RRECTIO N FILES 

Some measurement mics are sold with files that contain individually measured frequency response data for 

that specific microphone, which can be loaded in to Smaart RT to correct for deviations in the microphone’s 

magnitude response. With mics of reputable quality, these deviations tend to be very minor throughout most 

of the audible range (tenths of a dB). Although this is important information for laboratory test conditions, 

these small deviations are dwarfed by the natural variance that occurs in acoustic environments simply by 

moving the microphone a short distance.  

The top pane of the image below shows two measurements taken from the same microphone position with 

(red) and without (black) the microphone correction file loaded. The bottom pane shows the variation caused 

by moving the microphone one foot away.  

 

Figure 62 - The effects of a microphone correction file (top) vs the effects of moving the microphone a small distance (bottom)  

For this reason, microphone correction files are not typically necessary for field measurement work. However, 

there is a clear benefit to buying a microphone that includes correction data: the confidence that the 

manufacturer has tested the microphone and it is performing within its design tolerance. In other words: if 

your mic is of high enough quality to include a correction file, it is probably of high enough quality not to need 

one.   

Smaart can import individually measured frequency response data for a microphone in comma- or tab-

delimited ASCII text files having one frequency value (in Hz) and one magnitude value (in dB) per line. You can 

import a new correction curve file by selecting Import > Mic Correction Curve from the File menu, or by 

opening the Mic Correction Curve dialog from the Options menu and clicking Import. If the import is successful, 

the curve should immediately show up in the Mic Correction Curves dialog and in the Mic Correction Curve 

dropdown in IO Config. If not, the problem is likely a formatting error.  
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For more information on formatting correction curve files, please refer to the appendix. 

SO UND LEVEL C ALIBRATIO N (O NLY NEEDED FO R SP L MEASUREMENT)  

All of the measurement data produced by Smaart is produced by analyzing the incoming digital signals . Sound 

level measurements are unique in that they directly describe the strength of the fluctuations in in air pressure 

occurring at the microphone location. In order to allow produce SPL measurement data, Smaart needs to 

know what acoustic level at the microphone caused the incoming signal levels. This is accomplished by running 

the sound level calibration routine.  

Calibration is NOT required for standard Spectrum, Transfer Function or Impulse Response measurements. 

It is only required for measuring SPL. 

To complete the sound level calibration routine, you will need a sound level calibrator, which is a device that 

produces a known SPL at the diaphragm of the microphone, which Smaart can correlate with the incoming 

signal level, thus establishing the sensitivity of the entire input signal chain, from microphone to AD convertor. 

A sound level calibrator is a precision device that fits snugly over the measurement microphone capsule and 

generates a known acoustic level. Most calibrators produce levels of 94, 110 or 114 dB SPL, but it is not critical 

which level your calibrator produces as long as it is known. If your calibrator offers a choice, there is a slight 

advantage to using the higher level because it increases the signal to noise ratio of the calibration process and 

makes external and ambient noise less likely to disrupt the process.  

When you insert your measurement microphone into the sound level calibrator, do so slowly so as to avoid 

shocking and potentially damaging the microphone diaphragm. Most calibrators use a rubber seal or gasket of 

some type to ensure a proper seal. The fit should be snug, without wiggling or play. If you can clearly hear the 

calibrator’s tone once you turn it on, you may not have a solid seal.  

Once the calibrator is properly seated and is switched on, open Smaart’s Amplitude Calibration dialog by one 

of the following: 

• Clicking the Calibrate button at the bottom of the IO Config dialog 

• via Config > Amplitude Calibration 

The Amplitude Calibration dialog has dropdown menus at the top for you to select the device and input you 

wish to calibrate – ensure the selection is correct before you continue with the process. The Offset field 

displays the calibration offset for that input – the acoustic level that will bring the convertor to 0 dBFS. If the 

input hasn’t yet been calibrated, this number will be 0.0. The level meter on the right shows the signal level for 

the selected input, with a bit of time averaging applied to smooth out the reading, and should reflect the level 

of the input signal as caused by the calibrator. Once you have adjusted the input preamp to achieve the 

desired digital level, click the Calibrate button to run the calibration routine.  
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While the calibration process runs, avoid bumping the microphone and calibrator or making unnecessary 

noise. Once the process completes, it displays the measured digital level in dBFS RMS. Smaart will then ask 

you what acoustic sound level corresponds to this measured digital level. Enter the level produced by your 

calibrator into the Set this value to: field and press [Enter]. The Offset Required value displays the resulting 

calibration offset, which is the highest sound level that can be accommodated by your measurement setup in 

its current configuration without overloading your convertor. Click Okay to set the offset and close the dialog. 

Note that calibration describes the sensitivity of the entire signal chain from microphone to convertor, so if 

you plug in a different measurement microphone or adjust your interface’s preamp gain, you will need to run 

the calibration procedure again to determine the new offset. 

COMP ARING M EASUREMENTS 

Comparing multiple measurements is one of the most important ways to gain helpful insight from 

measurement data in Smaart. For example, you can compare multiple transfer function magnitude traces for a 

look at how the tonal response and level of the system vary over the coverage area, or you might compare 

phase traces from two different sources to see how well they will align at a given position. 

When comparing measurements, it is critical to keep in mind that measurements can only be meaningfully 

compared if they share a common reference to allow the comparison. For comparing transfer function 

magnitude measurements, this means preserving the measurement rig’s gain structure throughout all 

measurement acquisition. Since a change to the interface preamp levels for either the measurement or 

reference signals will cause a corresponding shift in the magnitude trace, this introduces a variable that 

prevents direct comparison of different measurements. Therefore, you should avoid adjusting the 

measurement microphone preamp levels during a measurement session if you plan to be able to directly 

compare the data gathered throughout the session. 

Similarly, to use the transfer function phase and Live IR graphs to investigate the relative arrival times of 

various sources at a given measurement location, the transfer function engine delay time setting must remain 

constant throughout the process, so the same time reference is used for all measurements. If the 

measurement delay is reset between measurements, the phase trance and Live IR peak will no longer indicate 

the relative time or phase offset between the sources.  
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5 – CONFIGURING MEASUREMENT ENGINES 

In Smaart, live measurement data is generated by measurement engines. Measurement engines come in two 

varieties: Spectrum measurement engines produce spectrum data and display it on spectrum-type plots (RTA 

and Spectrograph), and Transfer Function measurement engines products transfer function data and display it 

on transfer function-type plots (Magnitude, Phase and Live IR).  

Smaart’s Control Bar always shows controls and information relevant to the focused plot type. When a 

spectrum-type plot (RTA or Spectrograph) has focus, the label Spectrum appears at the top of the Control Bar, 

and spectrum engines and their corresponding controls are displayed.  

Likewise, when a transfer function-type lot (Magnitude, Phase or Live IR) has focus, the label Transfer Function 

appears at the top of the Control Bar, and transfer function engines and their corresponding controls are 

displayed.  

Access the Measurement Configuration flyout by clicking on the Hammer & Wrench icon in the Control Bar, or 

via Config > Measurement Config, or via the hotkey [Alt/Option] +[G]. This dialog shows all currently 

configured measurement engines, with Spectrum engines at the top and Transfer Function engines below.  

You can click the minus box (-) next to the Spectrum or Transfer Function heading to collapse the view of all 

measurements of that type and click the plus (+) to show it again. 

The Device column shows the input device that is feeding each measurement engine.  

In the case of Spectrum engines, which are single channel measurements, the input listed in the Meas. Ch. 

column feeds signal to the measurement engine. In the case of Transfer Function engines, which are dual 

channel measurements, the input listed in the Meas. Ch. feeds the measurement channel of the measurement 

engine, and the input in the Ref. Ch. column feeds the reference channel of the measurement engine. 

At the bottom of the measurement config flyout are a trashcan button to delete the currently selected 

measurement engine(s), an information button to view configuration details about a selected measurement 

engine, plus buttons to create new measurement engines.  

The New Spectrum Measurement and New TF Measurement buttons at the bottom of the dialog are used to 

create new measurement engines of both types, while the New Spectrum Average and New TF Average 

buttons create live averaging engines – see Creating and Configuring Live Averaging Engines on page 87.  

Double-clicking on the measurement’s name will make the field editable so you can rename it (be sure to 

press [Enter] to set the change). Double-clicking on any of the other fields will open the detail view, allowing 

you to view and adjust configuration parameters for that measurement engine. 

CO NTRO L BAR MEASUREM ENT ENGINE RIGHT -C LICK MENU 

Right clicking a measurement engine in the Control Bar opens a context menu that allows you to perform 

some common operations directly from the top level of the interface. Click Info to open the detail view for 

that engine in the Measurement Configuration flyout.  
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Remove from Tab will remove that engine from the Control Bar, while still leaving it configured for later use. 

Remove All Measurements from Tab does the same for all engines in the Control Bar.  

Duplicate will create another engine with the same configuration settings. 

Rename allows you to rename the engine – remember to press [Enter] to set the change.  

Change Color opens the Color Selection dialog to allow you to select a new color for the engine. 

You can also drag and drop engines to re-order them in the Control Bar, or drag them out of the Control Bar to 

remove them from active use. 

Engines removed from the Control Bar via either drag and drop, or the Remove commands are still configured 

and available in the Measurement Configuration dialog, from where they can simply be dragged back into the 

Control Bar for use. 

C REATING AND CO NFIGURING SPEC TRUM ENGINES 

When you selected your input signals (see Initial Configuration – Getting Input Signals on page 15), Smaart 

automatically created a spectrum measurement engine for each input. You can create additional Spectrum 

engines by any of the following:  

• clicking New Spectrum Measurement at the bottom of the Measurement Config flyout  

• via Config > New Spectrum, via the hotkey [Ctrl/Cmd] + [S]  

• by clicking the + Spectrum Engine “ghost engine” that appears in the Control Bar when a spectrum-

type plot (RTA or Spectrograph) has focus. 

The New Spectrum Measurement dialog prompts you to name the new engine, select a Device and a Channel 

for use. Devices and channels, along with their friendly names, will be as specified in the Input tab of IO Config. 

Then you can either click Create +, which creates the new engine and leaves the dialog open if you’d like to 

create additional engines, or Create & Close which creates the new engine and closes the dialog. 

 

Figure 63 - New Spectrum Measurement dialog 

Upon creating the new engine, it will appear in the Control Bar.  

Spectrum measurement engine configuration is handled in the engine’s Info detail view, which can be opened 

by any of the following: 

• Right-clicking an engine in the Control Bar and choosing Info 

• Double-clicking an engine in the Control Bar 

• Double-clicking any field other than the engine’s name in the Measurement Config Flyout 
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• Selecting it in the Measurement Config flyout and clicking the Info button at the bottom of the flyout 

[needs screenshot] 

The detail view is labeled with the name of the measurement engine at the top. You can view the details of a 

different engine without closing the flyout by clicking the up and down arrows to the right of the name label, 

or clicking a different engine in the Control Bar. 

The detail view is divided into three fields: Measurement Settings, Display Settings, and Input Settings. 

MEASUREM ENT SETTINGS 

In Smaart LE, the Measurement Settings group has four user-adjustable options. 

Name sets the name of the measurement engine – be sure to press [Enter] to set the name. 

Delay sets the signal delay time, in milliseconds, for the engine. Usually this setting is left at 0 but there may 

be circumstances in which you wish to delay the display of the measurement, for example, to more easily 

compare the ballistics of an RTA measurement of a mixing console’s output to that of a microphone placed 

some distance from a loudspeaker. Note that this is a special case setting and should not be confused with the 

measurement delay for Transfer Function measurement engines. 

FFT sets the FFT size used by the measurement engine. By default, the Use Global checkbox is checked, which 

means the engine will use the global FFT size setting in Options > Measurement Settings > Spectrum. Un-

checking Use Global will enable the FFT dropdown and allow you to select an FFT size specific to this engine. 

Available sizes are power-of-two FFTs from 128 to 32k samples.  

Averaging sets the temporal averaging used by the measurement engine. By default, the  Use Global checkbox 

is checked, which means the engine will use the global Averaging setting displayed in the Control Bar atop the 

Spectrum engine controls. Un-checking Use Global will enable the Averaging dropdown and allow you to 

select an Averaging setting specific to this engine. Available options are None, Fast, Slow and Infinite. 

D ISP LAY SETTINGS 

In Smaart LE, the Display Settings group has two user-adjustable options. 

Clicking on the Color swatch will open the Color Selection dialog and allow you to select a color for the 

measurement engine. See Trace Color and Thickness on page 36. 

Plot sets which plot the engine’s trace will appear on, in situations when more than one of the same plot type 

is available, for example, the RTA/RTA view. When only a single plot of a given type is available, this setting is 

ignored. See Moving Traces on page 35. 

INPUT SETTINGS 

The Input Settings group allows you to choose the signal that feeds the measurement engine. The Device 

dropdown lists all input devices that are selected for use in the Input tab of IO Config, and the Channel 

dropdown will allow you to choose an input channel from those you have enabled for use. These dropdowns 

will use the Friendly Names for the device and the channel if they have been specified in IO Config. 
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C REATING AND CO NFIGURING TRANSFER FUNCTIO N ENGINES 

Transfer Function engines can be created by any of the following: 

• clicking New TF Measurement at the bottom of the Measurement Config flyout  

• via Config > New TF  

• via the hotkey [Ctrl/Cmd] + [T] 

• by clicking the + TF Engine “ghost engine” that appears in the Control Bar when a Transfer Function-

type plot (Magnitude, Phase or Live IR) has focus. 

The New TF Measurement dialog prompts you to name the new engine, select a Device, and specify which 

inputs you want to use for the Measurement and Reference channels of the engine. Then you can either click 

Create +, which creates the new engine and leaves the dialog open if you’d like to create additional engines, or 

Create & Close which creates the new engine and closes the dialog. 

 

Figure 64 - New TF Measurement dialog 

Upon creating the new engine, it will appear in the Control Bar.  

Transfer Function measurement engine configuration is handled in the engine’s Info detail view, which can be 

opened by any of the following: 

• Right-clicking an engine in the Control Bar and choosing Info 

• Double-clicking an engine in the Control Bar 

• Double-clicking any field other than the engine’s name in the Measurement Config flyout 

• Selecting it in the Measurement Config flyout and clicking the Info button at the bottom of the flyout 
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Figure 65 - Transfer Function engine configuration flyout 

The detail view is labeled with the name of the measurement engine at the top. You can view the details of a 

different engine without closing the flyout by clicking the up and down arrows to the right of the name label, 

or clicking a different engine in the Control Bar. 

The detail view is divided in to three fields: Measurement Settings, Display Settings, and Input Settings. 

MEASUREM ENT SETTINGS 

In Smaart LE, the Measurement Settings group has four user-adjustable options. 

Name sets the name of the measurement engine – be sure to press [Enter] to set the name. 

Delay sets the amount of signal delay (in milliseconds) necessary to align the reference and measurement 

signals. Positive values delay the reference signal (the most common case). Entering a negative number delays 

the measurement signal.  

Averaging sets the temporal averaging depth used by the measurement engine. By default, the Use Global 

checkbox is checked, which means the engine will use the global Averaging setting displayed in the Control Bar 

atop the Transfer Function engine controls. Un-checking Use Global will enable the Averaging dropdown and 

allow you to select an Averaging setting specific to this engine. Available options are 1 thru 10 plus Infinite.  

The numbered values correspond as follows: 

1 = 2 FIFO 

2 = 4 FIFO 

3 = 8 FIFO 
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4 = Slow 

5 = 1 Sec 

6 = 2 Sec 

7 = 3 Sec 

8 = 5 Sec 

9 = 7 Sec 

10 = 9 Sec 

Average Type sets the mathematical averaging type used by the measurement engine to either Polar or 

Complex averaging. By default, all transfer function engines will use the global Mag Averaging Type average 

type setting in Options > Measurement Settings > Transfer Function. Unchecking the “Use Global” checkbox 

will enable the dropdown allowing you to select which averaging type should be used for this engine.  

For information about the difference between the two averaging methods, and why you might choose one or 

the other, see Polar Vs Complex on page 75. 

D ISP LAY SETTINGS 

Clicking the Color swatch opens the Color Picker which allows you to choose a display color for the 

measurement engine. See Trace Color and Thickness on page 36. 

Plot sets which plot the engine’s trace will appear on, in situations when more than one of the same plot type 

is available, for example, the Magnitude/Magnitude view. When only a single plot of a given type is available, 

this setting is ignored. See Moving Traces on page 35. 

Invert Magnitude Display will plot the engine’s magnitude response upside down. This can be helpful when 

setting loudspeaker equalization, as it allows a cut to be displayed as a boost, making it easier to see whether 

the filter response is appropriately complementary to the loudspeaker response being equalized. 

The Phase Smoothing and Mag Smoothing fields allow a measurement engine to override the in-plot 

smoothing settings. Un-checking the Use Global checkbox will enable the dropdown menu. 

 

INPUT SETTINGS 

The two sets of Device and Channel dropdowns allow you to select input signals to the engine’s Measurement 

and Reference inputs. If the Allow Multi-Device TF option is enabled in Options > Settings > Advanced, you will 

be able to select Measurement and Reference signals from different devices. Caution should be observed 

when taking a transfer function between different devices, as this cause result in clock drift in the 

measurement, resulting in unreliable phase / impulse response data. 

C REATING AND CO NFIGURING LIVE AVERAGING ENGINES 

In addition to generating averages from stored measurement data, Smaart can also generate averages from 

the output of multiple measurement engines in real time. To create a live average engine, click either New 

Spectrum Average or New TF Average at the bottom of the Measurement Configuration flyout. 
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LIVE SP ECTRUM AVERAGE 

The New Spectrum Average button opens the New Measurement Average dialog. 

 

Figure 66 - New Measurement Average dialog for Spectrum engines 

You are prompted to give the new engine a name, and choose either dB or Power averaging.  Select the 

checkboxes for the engines you want to contribute to the live average. Enabling Normalize will ensure that the 

outputs from all contributing spectrum engines are adjusted to be approximately equal level before being 

averaged with each other – you can indicate which engine should be used as the normalization reference by 

selecting its Ref radio button. (For more on dB vs Power averaging and normalization, see dB vs Power 

Averaging on page 77.) Clicking either Create + or Create & Close will create the live average engine. 

Live Transfer Function average engines are created in much the same way – click New TF Average and give it a 

name, choose the averaging type and whether you’d like it to be Coherence Weighted, then select the transfer 

function engines you wish to contribute to the average. 

Once live average engines are created, they behave much like any other measurement engine, with hide/show 

and run/stop controls in the Control Bar. Any measurement engines that are members of live average engines 

are always contributing their data to the average, regardless of whether they are shown or hidden, as long as 

they are running. Stopping a measurement engine will remove its contribution from the live average engine.  

ADD ING AND REMOVING ENGINES IN THE WO RKSP ACE 

The Measurement Configuration flyout lists all configured Spectrum and Transfer Function measurement 

engines. Measurement engines “live” in the Measurement Configuration flyout and can be dragged into the 

Control Bar when you want to use them, and then removed when you’re done with them. 

To add a measurement engine to the workspace, simply drag and drop it from the Measurement Config flyout 

into the Control Bar. To remove it, you can either simply drag it out of the Control Bar (it will disappear once 

you release your mouse button), right-click the engine and choose Remove From Tab, or clear them all at once 

by right-clicking any engine and choosing Remove All Measurements from Tab. 

MEASUREM ENT ENGINE CONTRO LS 

All measurement engines in Smaart have a triangle-shaped “Run” icon that looks very much like a “Play” icon 

on a multimedia device. Clicking the Run icon will turn the icon green and start the measurement engine 
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running. This also activates the engine’s signal level metering, which transitions from dark green to light green 

at signal levels of -60 dBFS, light green to yellow at -12 dBFS, and yellow to red at -6 dBFS. Click the Run button 

again to turn it grey and stop the measurement engine. 

All measurement engines have a colored circle on the left side of the engine area which corresponds to the 

color of the data trace that engine will produce in the graphs. Clicking on the colored circle will hide its data 

from the graphing area, as indicated by the “X” that appears over the colored circle to indicate the hidden 

state. Clicking again removes the “X” and unhides the live measurement data.  

 

Figure 67 - Two spectrum engines, one shown and one hidden 

When you stop an engine, its output is automatically hidden, but you can click the colored circle to show the 

data that is still in the measurement’s averaging buffer. The Pause All button at the top of the Control Bar 

effectively accomplishes both operations with a single click: stops the engines from running, but keeps their 

data displayed on the graph. 

At the top of the Control Bar are controls to Run All, Stop All and Pause all measurements. Run All will run all 

measurement engines. Stop All will stop them and hide them, while Pause All will stop them and keep their 

output visible on the graphs.  

 

Figure 68 - Spectrum Measurement controls in the Control Bar 

Transfer Function measurement engines have additional controls: instead of a single input level meter, there 

are a pair of input meters labeled M and R for the measurement and reference signals. A delay time field 

shows the measurement engine delay setting, in milliseconds. (See Delay Compensation on page 71). The 

small circle to the right of the delay time field indicates the status of the Delay Tracker. The circle is gray when 

the tracker is off, turns yellow while it’s running (momentary), and red when it’s locked on (latched).  

Click the tracker circle once to activate it momentarily – the circle will turn yellow, and the tracker will run 

until it has successfully found the proper measurement delay time. Once it’s gotten the same delay value 

three times in a row, it turns itself off. Double-click the tracker circle to latch it on – the circle will turn red, and 

it will continue tracking the delay time until you turn it off. 
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When you click on a measurement engine to give it focus, the engine enlarges slightly to make room for 

another row of controls that appears. 

 

Figure 69 - Transfer Function engine controls. The first engine has focus and its expanded controls for measurement delay can be seen 

Find opens the Delay Finder dialog and begins the process of finding the measurement delay. See  Delay 

Compensation on page 71. Track turns on the Delay Tracker – one click for momentary operation (yellow 

indicator), and two clicks for latched (red circle). When the Tracker is latched on, click Track to turn it off.  

The + and – buttons adjust the measurement delay value up or down by the increment specified in the +|- 

Increment field in the Options > Measurement Settings > Transfer Function dialog, where it can be specified in 

either samples or milliseconds. 
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6 – MAKING MEASUREMENTS 

Up to this point, we have learned about how to navigate and control Smaart and reviewed some fundamental 

measurement concepts. Now we will apply that knowledge in the context of a practical measurement 

workflow. We discuss here a typical generalized measurement workflow – the reader is encouraged to 

consider how they would adapt the process to meet their specific needs in a given situation. 

WORKING FROM DEFAULTS 

Given how much of this user guide is devoted to describing the various settings and parameters that may be 

adjusted by the user, it should come as no surprise that overlooking or forgetting that some settings have 

been adjusted can create unexpected measurement results and unintended behavior. For this reason, the user 

is strongly advised to begin a new measurement setting by restoring Smaart to defaults via Config > Manage 

Configurations > Restore Defaults. 

(Unlike in previous version of Smaart, restoring Smaart v9 to defaults happens in just a few seconds and 

doesn’t necessitate a program restart, so it’s a painless procedure.) 

Once the program has reset, we are greeted with a message explaining that no measurements are configured, 

and we should begin the process by selecting input sources. Clicking OK brings us to the Input tab of the IO 

Config dialog. 

INPUT AND O UTP UT SELECTIO N AND NAM ING 

For most measurement applications, all inputs will be coming from a single input device – selecting one will 

populate the bottom table in IO Config with a list of all the device’s inputs, and will select up to the first 8 for 

use by default. From here, we want to select and name the inputs we will use during our measurement 

session and deselect the rest.  

We can quickly Select / Deselect all a device’s inputs by clicking the word Use in the table’s column header. 

Selecting only the inputs needed for our session ensures that as we then configure our measurement engines, 

we will only be presented with signals we’re using as options. Each input in use gets a descriptive name, so we 

can recognize it everywhere it shows up in the program – and by default, this name will be adopted by the 

spectrum engines that are automatically created for each input as well.  

When setting up output devices, it is a good idea to assign a Friendly Name to each output describing where 

that signal is going – “To Loop,” “To DSP,” and so forth, makes output selection streamlined and minimizes the 

chance of confusion or misconfiguration.  

MEASUREM ENT SETUP 

Before we begin configuring Smaart for our purposes, we must consider what we wish to measure and 

translate that into an effective measurement configuration. Where should we pull signal tap points from? How 

many signals do we need to work with simultaneously?  

The use of friendly names coupled with the de-selecting of unused inputs during the input configuration 

process ensures that when we start creating the desired transfer function engines, Smaart only offers us a 

choice of clearly labeled inputs that have been selected for use, which speeds the configuration process and 

decreases the chance of making a mistake.  
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SIGNAL TAP POINTS 

Some consideration of what signals we wish to observe, or in other words, where in the sound system’s signal 

flow we want to tap the signal from, is in order. The mixing console output is helpful as the reference channel 

in a transfer function analyzing the sound system response, but also to observe directly via spectrum 

measurement. In addition, feeding a spectrum engine from the mixing console’s cue / solo output affords a 

close look at signals of interest. 

For a standard sound system alignment workflow, we can remove from the equation many complicating 

variables having to do with the mixing console by simply injecting our generator signal directly into an input of 

the DSP. If the generator is then also looped back locally at the IO device (from an output directly back to an 

input), this configuration, combined with a measurement microphone to capture the system’s output, allows 

transfer function analysis of the entire sound system transmission chain – from DSP inputs, through amplifiers 

and loudspeakers to the listening area. The entire system is in the measurement loop, and we will gain an 

understanding of what effect the sound system will have on the signals leaving the mixing console.  

GAIN STRUC TURE AND SI GNALS CHEC K 

Our measurement session begins by setting the gain structure of the measurement rig and conducting a 

signals check. Turning on the signal generator to a reasonable level, say, -12 dBFS and routing it through the 

system under test while observing Smaart’s input meters will allow us to make sure that all the selected inputs 

are properly receiving signal. Gain can be adjusted on each to bring the inputs into the analyzer at a healthy 

level (-12 dB is a good target, right where the meters transition from green to yellow). 

Microphone preamps can be set by raising the system level to the desired measurement level (not too loud, 

perhaps 15 dB SPL above the noise floor is all that’s required) and then adjusting the microphone preamp to 

bring the signal up to -12 dB FS or so.  

We can view all input signals at once by clicking the Run All button at the top of the Control Bar to start all 

spectrum engines running and then pressing the [0] key to launch multi-spectrum view.  

M IC ROPHO NE CO RRECTIO N CURVES 

Some measurement microphones include files with individually-measured frequency response data that can 

be loaded into Smaart to correct for deviations in the microphone’s magnitude response. With mics of 

reputable quality, these deviations tend to be very minor throughout most of the audible range (tenths of a 

dB). Although this is important information for laboratory test conditions, these small deviations are dwarfed 

by the natural variance that occurs when measuring in acoustic spaces simply by moving the mic a short 

distance.  

The top of the image below shows a measurement taken from the same microphone position with (red) and 

without (black) a correction file in use, and the bottom pane shows the variance caused by moving the 

microphone a foot away.  
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Figure 70 - The effects of a microphone correction file (top) vs the effects of moving the microphone a small distance (bottom)  

For this reason, mic correction files (not to be confused with “calibration”) are not necessary for typical field 

measurement work. However, there is a benefit to buying a microphone that includes individual correction 

data: the confidence that the manufacturer has tested the microphone and it is performing within its design 

tolerances. In other words: if your mic is of high enough quality to come with a correction file, it is probably of 

high enough quality not to need it. 

Since a microphone correction file adds offsets to the magnitude data early in the measurement pipeline, it 

cannot be removed from the measurement after the fact, and users often accidentally leave a microphone 

correction file assigned to an input while plugging in a different microphone, or taking an electronic 

measurement, producing unintended results. Thus, in a typical situation, there is little benefit from using 

microphone correction files in Smaart, and also a potential penalty for using one “accidentally.” 

M ULTIP LE M IC ROPHO NE WORKFLOWS 

Multiple microphones allow the acquisition of system response data from multiple listening locations at the 

same time. Since the alternative would be to move a single microphone around the space to the desired 

measurement locations, we are faced with the tradeoff of lower cost but higher acquisition time (single 

microphone being moved around), or higher cost (more microphones and a larger I/O device) vs faster 

acquisition. 

When multiple measurement microphones are to be used, we begin with a microphone verification process, 

which involves placing all the microphones in close proximity and ensuring they all provide the same answer. 

Preamps can be adjusted to compensate for different microphone sensitivity until the traces from all 

microphones overlay.  
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CH ANGING SETTINGS 

Smaart’s defaults have been carefully chosen over many years of development to allow you to achieve 

actionable data without first having to make an extensive visit to the program’s settings, and without deep 

knowledge of measurement mathematics. As such, it can safely be assumed that Smaart will get the job done 

in most situations running from the default settings, and can be adjusted as required by more specialized use 

cases. 

D ATA AC QUISITIO N 

Once the measurement rig has been configured and verified, data acquisition can proceed quickly. We can use 

the Fade In and Stop Gen After Capture signal generator settings to minimize disturbance to other parties 

working in the area and minimize the amount of time noise is being played through the system.  

It takes a handful of seconds to switch on the generator, set measurement delay using either Find or Track, 

flush the average ([V]), and capture the data, naming it after the noise stops. The data can then be analyzed, 

considered, any necessary system parameters adjusted, the mic relocated to a desired location, and the 

process repeated.  

Once the drive level of the system has been increased until the coherence trace stops improving, there is no 

further benefit to be gained by measuring louder. Thus, a system can be quickly and effectively measured 

using very short periods of noise at moderate levels, minimizing disturbance.  

D ATA LABELING AND O RGANIZATION 

Care should be taken to label stored measurement data in a way that will be useful if the data is revealed 

later. Simply relying upon the automatically suggested, numerically incrementing names will offer no context 

later. It is helpful to use descriptive names that include what part of the sound system is being measured and 

where the microphone was located. Numbering the data into discrete steps (for example: all Mic Verify traces 

are step 0, all “Pre EQ” traces are step 1, all Post EQ traces are step 2, and so forth) streamlines the data 

review process and conveniently allows the operating system to sort the data into a helpful order if it is 

transferred to another computer. 

CO LO RING AVERAGES 

When working with averaged data – either created by a live averaging engine, or generated from multiple 

stored traces – it is helpful to set the trace color to either white (when using the dark color scheme) or black 

(when using the light color scheme). Since Smaart will never randomly assign white or black to a captured 

trace, that color coding is a helpful visual shorthand that the data in question is an average. 

SEND ING DATA TO A CO LLEAGUE 

After a measurement session, you may wish to share the captured data with a colleague or client. All stored 

measurement data is housed in your computer’s Documents directly, inside the Smaart LE\Data folder, and 

further divided by data type (Spectrum or Transfer Function). Alternatively, you can right-click a saved trace in 

the Data Library and choose Open File Location to open your operating system’s file browser to that trace’s 

location on your hard drive. From here, it’s simple to copy the desired measurement data, or an entire folder, 
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to send to friends. Stored traces are small files (KB, not MB) and so can be easily transferred or stored without 

bandwidth or data capacity concerns. 

A GHO ST IN TH E MAC HINE 

If Smaart begins to exhibit unexpected behavior and you can’t seem to track down the culprit, you can quickly 

flush out any settings or configuration trouble that may be causing the issue by restoring the program to 

defaults (Config > Manage Configurations > Restore Defaults). This will reset the program configuration but 

preserve all captured measurement data, so your work will not be lost.  
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7 – MEASUREMENT EXAMPLES 

The following examples are designed to help you get acquainted with measurement procedure and workflow. 

The reader is strongly encouraged to work through the measurements themselves, with their own software 

and measurement rig. 

 

SETTING EQ FO R A LO UD SPEAKER 

In this procedure, we will measure a loudspeaker’s response from a few locations within its coverage area, 

create a spatial average of the data, and then set some equalization filters to address the response deviations, 

resulting in a more natural tonality for the loudspeaker. We will also use the Invert Magnitude function to 

confirm that our filter choices represent a good comp lementary response for the loudspeaker’s acoustic 

response. 

For illustrative purposes, we will start with Smaart running from defaults. We begin by choosing our input 

signals in IO Config and giving them friendly names – Mic and Loop In – as well as selecting outputs to drive 

the loopback and the system under test, which for this example consists of a processor and a loudspeaker. Our 

measurement mic is placed in the center area of the loudspeaker’s coverage. 

To keep our acquired data organized, we can click the hamburger (three-line) menu at the top of the Data Bar 

and choose New Session Folder, giving it a detailed name. This folder will hold all the measurement data 

captured during our session. 

Selecting the inputs in IO Config has created a spectrum engine for each using the friendly names we specified. 

We can click the Run All button in the Control Bar to start both spectrum engines running, then press the [0] 

key to open Multi-Spectrum view. We set the generator to a reasonable level, and run it using the [G] hotkey, 

adjusting the gains on the audio interface until both signals read at similar, healthy levels – around where the 

meters transition from green to yellow, which is -12 dBFS.  

Viewing both signals’ spectrums assures us that our patching is correct and our signal acquisition is good. If we 

want to quickly view either input signal in more detail, we can click to focus that plot and then press the 

[Enter] key to blow it up to the full window size.  
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Figure 71 - Viewing both input signals in Multi-Spectrum view to confirm good acquisition before beginning transfer function 

measurement work. 

Now, we will move to Transfer Function view by opening the View flying and clicking the T button. We need to 

create a Transfer Function engine using these two inputs, which we can do by clicking the + TF Engine ghost 

engine button in the Control Bar to open the New TF Measurement  dialog, naming the engine, and selecting 

the Mic as the measurement channel and the Loop In as the reference channel. Clicking Create & Close creates 

the engine and we are ready to work. 

 

Figure 72 - Creating a new TF engine 
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We click the Run button to start the transfer function measurement engine running and observe healthy signal 

levels on both of the engine’s level meters. As measurement data begins to populate in the graphing area, we 

see the telltale signs of an incorrect measurement delay. 

 

Figure 73 - Transfer Function data with improperly set measurement delay 

There are four such indications: 1) Peak in the Live IR is offset from center, 2) steep wrapping in the Phase 

trace, 3) stair stepping down in the coherence trace towards high frequencies, and 4) a value of 0.00 in the 

measurement engine delay field.  

To properly set the measurement delay, let’s click the Find button and let the Delay Finder produce a 

suggested measurement delay value. 

 

Figure 74 - Delay Finder suggests a measurement delay value of 3.08 ms. 

Since the microphone is a few feet from the loudspeaker, this suggested delay time makes sense, so we can 

click Insert to accept it. Now the data looks quite healthy. 



7 – Measurement Examples 
 

Smaart LE User Guide 99 Release 9.1 

 

Figure 75 - Transfer Function measurement of a loudspeaker with properly set measurement delay time. 

We will capture this trace using [Spacebar] and give it the name Pre EQ 1, then move our mic to another 

location within the central coverage area of this loudspeaker. Once we move the mic, we will again see 

indicators that the measurement delay needs to be reset. Since we have only moved a short distance and are 

working in favorable measurement conditions, we can use the Delay Tracker to quickly adjust to the proper 

measurement delay value and then turn itself off by clicking the Track button in the measurement engine.  

Once the new measurement delay value is set, a quick tap of the [V] key will flush the averaging buffer and 

populate our measurement with fresh data. Let’s save this as Pre EQ 2, and then repeat the process to take a 

third measurement from another nearby position.  

Now that we have three saved measurements from within the coverage area of the loudspeaker, we can click 

the colored circle in the transfer function engine to hide the trace while we work with the saved data. Since 

we intend to EQ for the general common trend, we set our smoothing to 1/6 Octave using the smoothing 

control in the lower right corner of the plot.  
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Figure 76 - Three measurements from within the coverage area with 1/6 Octave smoothing 

In the example, we can see that the pink trace was probably taken closest to the loudspeaker since it’s the 

highest broadband magnitude. We can confirm this by tapping the [Z] key to toggle through the z-order for 

the three displayed traces, and noting the measurement delay times shown for each in the center of the Live 

IR pane, with the pink trace showing the lowest delay time (closest mic position), and having the highest 

coherence (best direct:reverberant ratio).  

We want to create a spatial average of these three traces by multi-selecting them (click the first measurement 

in the data bar, then hold [Shift] and click the last) then right-clicking and choosing Average from the Data Bar 

right click menu. 

 

Figure 77 - Creating an average from the three selected traces 

In the Trace Average dialog, we set a descriptive name of Pre EQ Average and assign the color as Black, then 

click OK. The resulting spatial average is shown as a black trace, and appears in the Data Bar. 
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Figure 78 - Spatial Average in black 

Considering the average response, we may wish to use a gentle high shelf filter to neutralize the risin g 

magnitude response above 2 kHz and create a more pleasing tonality for the loudspeaker. We can use 

Smaart’s locked cursor functionality to determine the appropriate gain reduction that the filter should supply. 

If we want to know the dB rise from 2 kHz to 16 kHz, we can place our cursor at 2 kHz and then [Ctrl/Cmd] + 

click to set a locked cursor, then slide our cursor up to 16 kHz.  

 

Figure 79 - Using the locked and free cursors to view the amount of rise in the magnitude response between 2 kHz and 16 kHz 
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The differential cursor readout inside the brackets tells us that the level difference between the two cursor 

locations is 4.26 dB, so we will start by setting our EQ to a high shelf filter at 2 kHz with a gain reduction of 

about 4.5 dB.  

To observe the change in response, we unhide the measurement engine by clicking the colored circle, start 

our generator and acquire a new measurement.  

 

Figure 80 - Observing the effects of the high shelf filter 

If we are happy with the resulting response, we can capture the trace as Post EQ 1 and continue onto the next 

task. Otherwise, we can keep adjusting the EQ until the desired response is obtained.  

For informational purposes, we can directly measure the response of the EQ filters to confirm that they are a 

good match for the response we are attempting to correct. To do this, we can use the output of the equalizer / 

processor as our measurement signal, such that the measurement loop includes only the processor itself. 

Readjusting the preamp gain may be necessary, unless you are using an IO device with enough inputs to 

connect the EQ output while leaving your microphone connected. In this case, you can create a second 

transfer function engine to compare the DSP output against the loopback signal. 

The EQ’s response can be viewed alongside the Pre EQ average and the Post EQ stored traces to observe the 

relationship. 
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Figure 81 - Comparing the EQ response to the Pre and Post loudspeaker response  

To make this more visually straightforward, we will double click the transfer function engine to open the 

measurement config flyout, and check the Invert Magnitude Display option. This allows us to easily confirm 

that the filter’s response curve is a good fit to counteract the rising magnitude response of the loudspeaker at 

high frequencies. 

 

Figure 82 - Viewing the inverted EQ response compared to the Pre and Post loudspeaker response traces 
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O BSERVING NEAR FIELD VS FAR FIELD RESPO NSE  

In this exercise, we will measure a loudspeaker’s response in the nearfield, where the measurement will have 

a high direct:reverberant ratio, and then measure again further back in the space to observe the effects of the 

acoustic environment. 

We have configured our Smaart rig the same way as in the previous example, and started a new session folder 

for the captured data. Once signal acquisition has been verified and a transfer function measurement created 

(see previous example), we are ready to begin by placing our measurement mic in the nearfield of the 

loudspeaker, staring the generator and the transfer function measurement engine running, and then setting 

our measurement delay using the Delay Finder or Delay Tracker. The measurement is acquired, captured, and 

named 1 NEAR. 

 

Figure 83 - Nearfield measurement 

Note the relatively high overall coherence, as one would expect from favorable measurement conditions. Now 

we move our microphone further back into the acoustic environment and measure again to observe the 

change, making sure to properly reset the measurement delay time. 
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Figure 84 - Far Field measurement 

Our new measurement, stored as 2 FAR, shows a broadband level reduction as we would expect from moving 

farther from an acoustic source. In addition it shows a drop in coherence due to the decrease in 

direct:reverberant ratio. In addition, the influence of the room is obvious, especially at low frequencies, where 

our loudspeaker has poor directivity. This is evidenced by the greatly increased micro-ripple in the magnitude 

and phase traces, and the steep downward wraps in the phase trace indicating late-arriving energy. 

We can easily and directly characterize the level loss by using the dB + and dB – buttons in the command bar 

to apply a trace offset to the 2 FAR trace until it overlays the 1 NEAR trace, and then reading the resulting dB 

offset value from the upper right corner of the magnitude plot. 

 

Figure 85 - a trace offset of 7.0 dB 
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APPENDIX B:  BOUNDARY EFFECTS 

ACOUSTICALLY SM ALL SO URCES 

Acoustically small sound sources are sources whose dimensions are small compared with the wavelengths 

they produce. Away from boundaries, acoustically small sources tend to be omnidirectional. 

A single-driver 1m cube subwoofer would be a good example of an acoustically small sound source as its size 

would be less than a quarter of the wavelength at low bass frequencies. At 80Hz, for instance, the wavelength 

would be just over 14 ft (~4m). 

The effective directivity of an acoustically small source tends to be governed by local boundaries. The 

illustration shows a large room with some identical, acoustically small (red spherical) sources in various 

positions with respect to the room boundaries. (Ignore Victor. He’s only there to avoid 3-D ambiguity.) 

• The source that is dangling in free space has a 

Directivity Factor (Q) of 1 and radiates its 

acoustic power spherically – into full space. 

• The mid-floor source (Q=2) has its acoustic 

power concentrated into a hemisphere. It 

radiates the same power but concentrated 

into half-space. 

• The baseboard source (Q=4) has its acoustic 

power concentrated into a quarter-sphere. 

Again, it radiates the same power but, this 

time, concentrated, into quarter space. 

• And the rear corner source (Q=8) has its 

acoustic power concentrated into an eighth-

sphere – radiating the same power but, this 

time, concentrated, into eighth space. 

Useful on-axis free field sound pressure level/headroom increases, with respect to Q=1, will approach 6dB per 

boundary: 

• +6dB for Q=2 (half space) 

• +12dB for Q=4 (quarter space) 

• +18dB for Q=8 (eighth space) 

M IC ROPHO NES NEAR BOUND ARIES 

Similar SPL increases apply to pressure microphones if they are placed acoustically close to a surface – i.e., 

much less than 1/6th of the shortest wavelength of interest. At 1/6th wavelength, the “round trip” will be 1/3rd 

wavelength, causing a 120° phase shift and resulting in unity gain summation. Larger spacing would cause 

partial or full cancellation and combing.  

Placing a microphone capsule on the center of a large surface can be useful when measuring, for instance, PA 

systems in an empty room devoid of seats, as the reflective qualities of the floor will only be visible as a 6dB 

increase in overall level. 

Q = 1 

Q = 2 

Q = 4 

Q = 8 
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Placement of the microphone in relationship to the floor is critical in this type of measurement, as the 

reflection from the floor still causes a comb filter. The object of the exercise is make the path of the first 

reflection so short, relative to the path of direct sound, as to push first null in the resulting comb filter well 

above the audible spectrum. If the path of the floor bounce is more than a few millimeters longer than the 

path of direct sound, the fist null of resulting comb filter will be low enough to produce at least a visible 

lowpass filter function in the top octave, if not an actual null within the audible spectrum.  

 

The chart above shows comb filter functions for 9, 18 and 36 μs reflections respectively, which would equate 

to reflected path lengths approximately one eighth, one quarter and one half inch (3, 6, and 12 mm) longer 

than the path of direct sound. A common strategy for minimizing this issue is to rest the barrel of the 

microphone on a coil of cable so that the capsule is actually in contact with the floor or very nearly so. It may 

also be preferable to use a small diaphragm microphone to further limit the maximum possible length of the 

floor bounce path. 
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APPENDIX C: TYPICAL MEASUREMENT RIG SET -UP 

The following are some example measurement-system setup diagrams for transfer function and dual-channel 

IR measurement in Smaart. Dual-channel measurements are made by comparing a reference signal (system 

input) and a measurement signal (system output). They are an essential tool for aligning loudspeaker systems 

because unlike “time-blind” single-channel RTA measurements, dual-channel measurements can show you 

both the magnitude and phase response of a system – that is, both energy and timing. Additionally, the same 

pair of signals (reference and measurement) can be used to calculate the coherence function, an assessment 

of the linearity of a system that can provide important clues about signal-to-noise ratio, reverberance and 

overall quality of your measurement data. 

STEREO (2X2) AUD IO I -O 

In this example, Smaart’s internal signal generator is used to excite the system under test. The signal 

generator is assigned to output 1 of a 2-in/2-out audio input-output (I-O) device, labeled Stereo Audio 

I-O in the diagram below. The audio I-O device is connected to the computer via USB or Firewire. Output 1 on 

the audio I-O is connected to the input of the system under test and also routed back to input 1 on the audio I-

O using a Y-split cable (a hard-wired loop-back). Input 1 on the audio I-O will be assigned as the reference 

signal of a transfer function measurement in Smaart. A measurement microphone connected to input 2 of the 

I-O device provides the measurement signal. 

 

Basic connections and routing should be pretty much the same for any audio I-O device you may encounter. 

We trust that you understand the audio cabling and connections necessary connect your equipment together. 

Note that the audio I-O device in this case could conceivably be the computer’s built-in stereo line input and 

headphone output, in conjunction with a self-powered measurement microphone or external mic preamp and 

phantom power supply and a little bit of creative cabling. 

Speaker

Measurement
Microphone

USB or 
Firewire

Acoustical Environment

Computer
Measurement 
Signal In (Mic)

Signal Generator Out 
/ Reference signal In

Stereo Audio I/O  

INOUT

Power Amplification 
and Processing
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M ULTI-C HANNEL I-O  

In version 7, Smaart introduced the capability to run and display as many simultaneous real-time spectrum 

and transfer function measurements as your computer can handle. Having a multi-channel I-O device enables 

you to set up multiple microphones to compare different measurement positions in real time, without a lot of 

running around. This can be a huge advantage when working with larger, more complex sound systems. 

TRAD ITIO NAL USB/FIREWIRE STAND -ALONE INTERFACES 

Eight-channel, single rack space packages are a common form factor for multi-channel audio interfaces. The 

single rack space format makes portability in a rack case, or in your backpack, equally viable. In addition to 

fielding more microphones, having more audio inputs to the computer enables you to tap into multiple 

electronic measurement points in a system. 

 

In the diagram above, we have three measurement microphones set up, along with electronic measurement 

points pre-system-processing and pre-loudspeaker-system. There is also a hard-wired loopback pre-console. 

The Console Out and DSP Out can be used as reference signals that let you isolate the response of the system 

post-console or post-DSP. Alternatively, they can be used as measurement signals for analyzing the console, 

EQ, or crossover response in Smaart. 

NETWO RK AUD IO I-O  

The ability to digitize an audio system from end-to-end, from stage pre-amps, all the way to the loudspeaker 

system(s) has become a reality in the past few years. In some professional sound systems, the only analog 

signals present are those from the microphones to the stage conversion box, where they are digitized and 

then distributed wherever they are needed via the network. 
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In this scenario, all you might need in terms audio I/O hardware for Smaart is a way to connect your computer 

to the network. Using the Audinate® Dante® network protocol as an example, a single connection to your 

computer’s Ethernet port makes any signal from any source connected anywhere on the network potentially 

available for analysis in Smaart and enables you to send test signals from Smaart to any destination on the 

network that is capable of receiving an input stream. The Dante Virtual Soundcard software application 

presents a selected group of audio streams from the network to Smaart as a standard, multi -channel ASIO or 

CoreAudio device. Smaart sees the virtual I-O device, just as it would any locally connected USB or Firewire 

audio I-O. Selected audio streams from the network appear as input channels on the virtual I-O device and 

Smaart’s signal generator can be assigned to its output channels. Routing is done within the Dante Controller 

application. 

Audinate and Dante are trademarks of Audinate Pty Ltd.  
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APPENDIX D: TEXT FILE FORMAT  FOR ASCII IMPORT 

Smaart uses plain ASCII text for importing frequency domain data as microphone calibration curves. 

The minimum requirement for importing any type of curve is one frequency value in Hertz and one magnitude 

value in decibels per line, separated by a tab character – commonly referred to as tab-delimited ASCII text 

format. Smaart will also ignore blank lines and any line beginning with a semicolon (;) or an asterisk (*), and so 

the latter may be used to add comments, headings, or line spaces to help make data files more human-

readable. 

Tab-Delimited Text 
; Free field Microphone Response 
; Sensitivity: 6.27 mV/Pa @1kHz 
;Freq 
10.00  
10.40  
10.82  
11.26  
11.71  
12.18  
12.68  
13.19  
13.72  
14.27 

→ 
→ 

→ 
→ 
→ 

→ 
→ 
→ 
→ 

Mag (dB) 
-2.22  
-1.90  
-1.84  
-1.73  
-1.51  
-1.43  
-1.47  
-1.28  
-1.08  
-1.05 

Example of a two-column tab-delimited ASCII text data 

set. The light blue arrows indicate [Tab] characters. Lines 

beginning with semicolons [;] will be ignored on import. 

Smaart accepts the ASCII period (a.k.a., point, dot, or full stop) character [ . ] or comma [ , ] as the decimal 

mark, to separate the whole number parts of real numbers from the fractional parts in ASCII import 

operations. CSV (comma-separated-values) formatted text files is therefore not supported for import. If you 

wish to import values from a CSV formatted text file, commas used as field delimiters must be replaced with 

tab characters and quote marks around values (if applicable) must be removed.  

 

 

 


